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fonctionnalités de votre nouveau
ecteur MP3

Elégant, intelligent, fiable et tres pratique : votre nouveau lecteur MP3 est tout
cela a la fois et plus encore | Sa technologie de pointe offre une qualité de
son et d'image exceptionnelle et permet d'accéder a des jeux pleins d'action.
Vous ne pourrez plus vous passer de votre nouveau lecteur MP3, que ce soit
pour pratiquer une activité physique, télécharger vos chansons préférées,
regarder des vidéos, utiliser des jeux ou méme écouter la radio.

Utilisez-le ne serait-ce qu'une seule fois et vous vous demanderez comment
VOUS avez pu vivre sans |

TOTALEMENT MULTIMEDIA ECOUTE PROLONGEE ET DUREE DE
Nous I'appelons lecteur MP3 mais c’est bien TELECHARGEMENT REDUITE !

plus que ca. Il permet d'afficher des images, du  Une batterie entiérement chargée permet

texte, des vidéos d’écouter la radio et méme de lire jusqu’a 30 heures de musique ou 4
de jouer. heures de vidéo.

La durée de téléchargement a en outre été
LA NAVIGATION TACTILE ! sensiblement réduite. Grace au standard
Le pavé tactile vous permet de naviguer dans ~ USB 2.0, le lecteur est bien plus rapide que
les différents menus trés facilement. les modéles utilisant le format USB 1.1.

ASPECT DE L’ECRAN COULEUR LCD UNE QUALITE D’ECOUTE EXCEPTIONNELLE

Des images aux couleurs vives peuvent étre  Votre nouveau lecteur MP3 intégre la
affichées sur I'écran LCD. technologie sonore exclusive DNSe™ (Digital

Natural Sound engine) de Samsung, fonction
LA LIBERTE D’ECOUTER VOTRE MUSIQUE permettant de fournir un son d’une pureté
FAVORITE OU VOUS LE VOULEZ! et d’une richesse incroyable pour un plaisir
d’écoute inégalé.

Vous pouvez créer des listes de lecture avec
votre musique préférée.



Signification des icones et symboles utilisés dans ce
manuel d’utilisation :

A\

AVERTISSEMENT

Indique un risque de blessure grave, voire mortelle.

Indique un risque potentiel de blessure ou de dégat
matériel.

ATTENTION
2 Pour diminuer les risques d’incendie, d’explosion, de
décharge électrique ou de blessure lorsque vous utilisez le
ATTENTION | lecteur MP3, respectez les consignes de sécurité suivantes :
Indique des conseils ou des pages auxquelles se référer
REMARQUE | afin d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fiche de la prise murale.

QuEEEV

Appeler le service d’assistance technique pour obtenir de I'aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous
blesser et de blesser d’autres personnes.

Veuillez respecter scrupuleusement les consignes.

Aprées avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit sir afin
de pouvoir vous y référer ultérieurement.



Ce manuel vous indique comment utiliser correctement votre nouveau
lecteur MP3. Lisez-le attentivement avant toute utilisation afin d'éviter
d’endommager votre lecteur ou de vous blesser.

Portez particuliecrement attention aux avertissements suivants :

PROTEGEZ-VOUS

= Ne prenez pas l'initiative de démonter, réparer ou modifier cet appareil
vous-méme.

= Evitez de mouiller I'appareil ou de le faire tomber dans 'eau. Si une
wmemon  telle situation se produit malgré tout, n’allumez pas le lecteur car vous
risqueriez de vous électrocuter. Contactez plutét le service clientéle de
Samsung le plus proche de chez vous.

= N'utilisez pas ce produit en cas d’orage et de foudre. Vous vous
exposeriez a un risque de dysfonctionnement ou de décharge électrique.

= N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une
smamon @utomobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L'utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur
les passages piétons, peut se révéler trés dangereuse.

= Faites particulierement attention lorsque le cable USB du lecteur n’est
pas branché et pend dans le vide.
La fiche USB possede des bords tranchants et risque de vous blesser.

= Ne conservez pas I'appareil dans un endroit humide, poussiéreux ou
wemsmer cOUvert de suie ; vous risqueriez de provoquer un incendie ou une
décharge électrique.



PROTEGEZ-VOUS

A = 'utilisation prolongée des écouteurs ou du casque peut fortement réduire

wemsseie — vVotre acuité auditive.
Si vous vous exposez a un volume sonore supérieur a 85 dB pendant une durée

& prolongée, votre ouie sera irrémédiablement endommagée. Plus le son est élevé, plus
votre acuité auditive diminue (le niveau sonore d’une conversation ordinaire est compris
entre 50 et 60 dB alors que celui provenant d’une route est d’environ 80 dB).
Il est fortement recommandé d'utiliser un volume sonore moyen (le volume moyen est
habituellement inférieur de 2/3 au volume maximal).

= Si vous ressentez des bourdonnements dans les oreilles, réduisez le
volume ou n'utilisez plus les écouteurs ou le casque.

PROTEGEZ VOTRE LECTEUR MP3

& = Ne laissez pas I'appareil dans un lieu ou la température excede 35°C

(ex. : sauna ou voiture en stationnement).

= Evitez tout choc brutal (ex. : chute).

= Ne posez pas d’objets lourds sur I'appareil.

= Empéchez que des particules externes ou de la poussiére ne pénétrent
dans I'appareil.

= Ne posez jamais I'appareil a proximité d’objets émettant des ondes
électromagnétiques.

= Veillez a toujours enregistrer vos données les plus importantes. Samsung
ne saurait étre tenu pour responsable en cas de pertes de données.
= Utilisez uniquement les accessoires fournis ou agréés par Samsung.

= Evitez toute projection d’eau sur I'appareil. Ne nettoyez jamais I'appareil a I'aide
amenton — de produits chimiques (ex. : benzene ou diluant) ; vous risqueriez de provoquer
un incendie ou une décharge électrique ou d’en détériorer la surface.
A = Suivez attentivement ces instructions afin d’éviter de vous blesser ou
ATTENTION d'endommagel’ le lecteur.

= Nous vous conseillons d'imprimer ce mode d’emploi en couleur et de
remrave  parameétrer 'option d’impression « Ajuster a la taille de la page » pour
qu’il soit plus agréable a lire.
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FONCTIONS DE BASE 10 Contenu

11 Votre lecteur MP3

14 Ecrans

17 Utilisation des boutons tactiles

18 Chargement de la batterie

19 Entretien de la batterie

19 Mise sous et hors tension de
I'appareil

20 Lecture de musique

20 Controle du volume

21 Verrouillage des boutons

21 Recherche de fichiers a I'aide du
« Dossier Navigateur »

22 Supression de fichiers a I'aide du «
Dossier Navigateur »

23 Modification des reglages et des
preferences
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24 Réglages du son

25 Réglages de I'affichage

26 Réglages de la langue

27 Réglages de la date et I'heure

28 Réglages du systéme

32 Reinitialisation du systeme

EMODIO 33 Configuration requise
34 Installation d’EmoDio
35 Utilisation d’EmoDio
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40 Lecture d’une liste de lecture

41 Suppression d’un fichier de la liste de
lecture

41 Suppression de tous les fichiers de la
liste de lecture

42 Utilisation du menu musique

REGARDER UNE 54 Regarder une vidéo
VIDEO 54 Pause

55 Passer a une sequence specifique
55 Lire le fichier vidéo precedent

55 Lire le fichier vidéo suivant

56 Utilisation du menu vidéo
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AFFICHAGE DES 58 Affichage des images
IMAGES 59 Utilisation du menu image

LECTURE DE TEXTE 64 Lecture de texte

65 Utilisation du menu texte

ECOUTER LA RADIOFM 71 Ecouterlaradio FM
71  Pour utiliser la fonction mute
(silence)
72 Pour rechercher des stations de radio
FM
73 Utilisation du menu de la radio FM

AFFICHAGE DES 80 Affichage des diffusions de données
DIFFUSIONS
DE DONNEES
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UTILISATION DU PACK 81 Enregistrement vocal
PLUS 83 Lecture de jeux flash

85 Affichage de la carte internationale
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DEPANNAGE 86 Dépannage
ANNEXE 89 Arborescence des menus
9

0 Caractéristiques du produit
92 Licence



CONTENU

Votre nouveau lecteur MP3 est fourni avec les accessoires présentés
ci-dessous. Sil'un de ces éléments ne se trouve pas dans I'emballage,
contactez le service clientele de Samsung.

Ecouteurs

Céble USB CD d’installation

Il se peut que les accessoires livrés avec votre appareil soient [égérement
différents de ceux illustrés.
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VOTRE LECTEUR MP3

| ___———Trou de la cordelette

Interrupteur Alimentation et
Verrouillage ® (O é
Faites glisser vers le bas du lecteur
pour allumer/éteindre I'appareil.
Faites glisser vers le haut du lecteur
pour verrouiller les fonctions des

boutons.

Bouton de réinitialisation

Si un dysfonctionnement du lecteur
survient, appuyez sur le bouton de
réinitialisation a I'aide d’un objet
pointu afin de réinitialiser le systéeme.

/—| Microphone

T
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VOTRE LECTEUR MP3 (Suite)

Les boutons suivants sont des touches tactiles.

[ Bouton de menu |——
Appuyez légerement pour afficher I'écran de
menu.

Bouton d’augmentation du volume |——

Appuyez légérement pour augmenter le
volume ou accéder a I'élément/au menu
précédent.
“ Bouton de retour en arriére
Appuyez légerement pour aller a I'écran
précédent. Appuyez longuement sur ce bouton
pour accéder a I'écran du menu principal

Bouton d’acceés au fichier précédent

Ce bouton permet de sélectionner la plage/le
menu précédent(e) ou de lire la plage en

cours a partir du début. Appuyez longuement

sur ce bouton pour passer rapidement d'une
plage a une autre..

Bouton de lecture/pause, sélection

Appuyez légérement pour sélectionner la lecture/
pause et la fonction et accéder a I'écran suivant.

Bouton de réduction du volume

Ce bouton permet de diminuer le volume ou
d’accéder a I'élément/au menu suivant.

Bouton d’accés au fichier suivant
Ce bouton vous permet d’accéder a la plage/au
menu suivant(e). Appuyez longuement sur ce
bouton pour passer rapidement d’une plage a une
autre.

12 _ fonctions de base



VOTRE LECTEUR MP3 (Suite)

—| Prise pour écouteurs

Trou de la cordelette I—|

Port USB

Ecouteurs |

Pour votre confort, les lettres L
(écouteur gauche) et R (écouteur
droit) sont gravées sur chaque
écouteur. Ce cordon sert également
d’antenne radio.

Si vous débranchez les écouteurs
pendant la lecture des données

musicales, la lecture s’interrompt.
P fonctions de base _ 13



ECRANS

Musique

Témoin du menu associé

Témoin verrouillage

Etat de la batterie

Témoin de lecture de la plage en
cours/du nombre total de plages

Témoin de vitesse de lecture

Heure actuelle

Durée de lecture totale

Témoin Lecture / Pause /
Recherche

Témoin du mode Musique

Témoin du mode Lecture

Témoin du mode DNSe

Ecran Lect mus.

Titre de la plage

Barre d’état de la lecture

BHEERRBEEEHE® E BEE

Durée de lecture actuelle

= Les représentations a I'écran figurent a titre indicatif uniquement.
remaraue  L'écran réel de votre appareil peut étre différent.
= Les informations non liées a I'écran de lecture musicale s’affichent trés brieévement.
Pour les visualiser a nouveau, appuyez légérement sur n'importe quel bouton.
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ECRANS (Suite)
Vidéo

Témoin verrouillage

Etat de la batterie

Heure actuelle

Durée de lecture totale

Témoin Lecture / Pause /
Recherche

Témoin du mode Vidéo

Nom du fichier

Barre d'état de la lecture

Durée de lecture actuelle

Témoin verrouillage

Etat de la batterie

Témoin du fichier en cours/
du nombre total de fichiers

Heure actuelle

Etat de la lecture des
fichiers musicaux

©®EHE] @EME®EBEE

@ Témoin du mode Image

Témoin du menu associé

[Ecran de prévisualisation] Nom du fichier
fonctions de base _ 15




ECRANS (Suite)

Radio FM

Heure actuelle

Etat de la batterie

Témoin verrouillage

Témoin du mode Radio

Témoin Manuel / Présélectionné

Témoin de la fréquence en cours

&HEEHEHEE®

| [ (MHz)
= == o Témoin de la barre de fréquence
radio
Témoin RDS

7
= Qu’est-ce que le RDS ?

REWARQUE | a fonction Systéme de Radiocommunication de Données (RDS) permet la
réception et I'affichage de messages comme la diffusion d’informations. Les
informations relatives aux programmes (ex. : actualités, sport ou musique) ou aux
stations de radiodiffusion s’affichent sur cet écran.

= Si la puissance du signal FM est faible, les informations RDS ne s’affichent pas.
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UTILISATION DES BOUTONS TACTILES

Appuyez légérement sur le bouton tactile du bout du doigt.

oo D&

o Dé

= Afin de ne pas endommager le bouton tactile, utilisez uniqguement vos doigts pour
remaraue  I'activer.

= Veillez toujours a avoir les mains propres avant d’utiliser votre appareil.
= N'utilisez jamais le bouton tactile les mains gantées.

= |l est possible que le bouton ne fonctionne pas si vous utilisez votre ongle ou un
autre objet tel qu’un stylo a bille.

fonctions de base _ 17



CHARGEMENT DE LA BATTERIE

Chargez-la avant d'utiliser votre lecteur pour la premiére fois ou lorsque vous
ne l'avez pas utilisé pendant une période prolongée.

La batterie de votre lecteur MP3 se charge complétement en environ trois
heures, mais cette durée peut varier en fonction de la configuration de votre
ordinateur.

Affichage a I'écran
= USB connected
(USB connecté)
= <1]> - Chargement

= <{m] > - Chargement
terminé

1. Branchez I'extrémité la plus large du cable USB sur le port de connexion
USB situé dans la partie inférieure du lecteur.

2. Branchez le cable USB sur le port USB (+<+) de votre ordinateur.

18 _ fonctions de base



ENTRETIEN DE LA BATTERIE

La batterie durera plus longtemps si vous respectez les consignes d’entretien et
de rangement du lecteur.

* Rechargez la batterie dans un lieu ou la température est comprise entre 5 et 35 °C.

» Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger
la batterie a des fréquences trop rapprochées peut réduire sa durée de vie.

* Comme pour tout autre produit de consommation, la durée de vie de la
batterie raccourcit progressivement avec le temps.

@ = Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie
remaraue  du portable est entiérement chargée ou que l'ordinateur est lui-méme relié a une
prise secteur.

= La batterie rechargeable intégrée a ce produit ne peut pas étre remplacée par
arrention  ['utilisateur. Pour plus d’'informations sur son remplacement, contactez votre
fournisseur de services.

MISE SOUS ET HORS TENSION DE L’APPAREIL

Mise sous tension de I'appareil

A
Faites glisser l'interrupteur [0 CC_T ) &] vers le bas du n @ a
lecteur. a é N
= L'appareil s’allume. *
. . s .
M|§e hors tension ‘de I'appareil =.a [ @ @
Faites a nouveau glisser l'interrupteur [0 CC_O ) &] vers le  [RERERHT= IS

bas du lecteur. 06:46¢em
= |'appareil s'éteint.

= L'appareil s’éteint automatiquement lorsque aucun des boutons n’est actionné
remaraue  pendant une durée prédéfinie en mode Pause (Pause). La durée par défaut de
<Auto Power Off> (Extinction auto) est de 1 minute, mais vous pouvez la modifier.
Consultez la page 29 pour plus d’informations.
fonctions de base _ 19



LECTURE DE MUSIQUE

Téléchargez des fichiers musicaux sur votre nouveau lecteur MP3 a l'aide de
EmoDio.

1. Appuyez longuement sur [ © ] pour accéder a I'écran du I7F cazroum
menu principal. Music 15720

O NORIAL

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner <Music> (Musique), puis sur le
bouton [Sélection].

3. Servez-vous du bouton [Haut, Bas] et du bouton
[Sélection] pour sélectionner le fichier musical de votre REGEw
choix. el

4. Appuyez légérement sur le bouton [Sélection] pour lire le fichier musical
sélectionné.

= La lecture du fichier musical démarre.
= Appuyez légérement sur [ ] pour aller a I'écran précédent.
REMARQUE m  Appuyez longuement sur [ © ] pour accéder a I'écran du menu principal.

CONTROLE DU VOLUME

Appuyez légerement sur le bouton [Haut, Bas].
= Licéne du contréle de volume s’affiche. oL
= La plage de réglage du volume est comprise entre 0 et 30.

= Appuyez légérement sur le bouton [Haut] pour augmenter le
volume et sur le bouton [Bas] pour le diminuer.
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VERROUILLAGE DES BOUTONS

La fonction Verrouillage permet de verrouiller tous les boutons du lecteur MP3 ;

ainsi, si vous appuyez sur une touche par mégarde lors de la lecture d’'un

fichier, celle-ci ne sera pas interrompue. e
15/20

1. Faites glisser I'interrupteur [ CC_O) &] vers le haut du
lecteur pour activer la fonction de verrouillage.

O NORIAL

2. Faites glisser 'interrupteur [0 CC_O)a] vers le bas du
lecteur pour désactiver la fonction de verrouillage.

RECHERCHE DE FICHIERS A L’AIDE DU
« DOSSIER NAVIGATEUR »

Recherchez des fichiers en toute simplicité grace la fonction <File Browser>

(Dossier Navigateur).

1. Appuyez longuement sur [ © ] pour accéder a I'écran du
menu principal.

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner <File Browser> (Dossier

MUSIC  VIDEOS  PICTURES

==

Navigateur), puis sur le bouton [Sélection]. ™
= Le dossier <File Browser> (Dossier Navigateur) contenant ﬁ.‘ td @
des fichiers musicaux, des listes de lecture, des vidéos, des PRINE PACK golliEes  SETTINGS

images, des listes de diffusion, des textes, des jeux, des fichiers 06:46
enregistrés et Mon pack apparait. SO

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le dossier
souhaité.
4. Appuyez légérement sur le bouton [Sélection] pour afficher la liste des
fichiers dans le dossier sélectionné.
= Appuyez légérement sur [ © ] pour aller a I'écran précédent.
5. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le fichier souhaité.
6. Appuyez Iégérement sur le bouton [Sélection].
= La lecture du fichier démarre. fonctions de base _ 21




SUPRESSION DE FICHIERS A L'AIDE DU « DOSSIER
NAVIGATEUR »

1. Appuyez longuement sur [*© ] pour accéder a I'écran du
menu principal.

oaz27pM @

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner <File Browser> (Dossier

i ; 4 P Pictur
Navigateur), puis sur le bouton [Sélection]. :D;‘;‘;z‘s
= Le contenu de la liste des dossiers <File Browser> (Dossier B Texts
Navigateur) apparait. mGames
M Recorded Files
3. Appuyez légérement sur le bouton [Haut, Bas] pour RS
sélectionner le dossier souhaité, puis sur le bouton
[Sélection].

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le fichier
que vous souhaitez supprimer, puis sur [ @ ].

5. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner <Delete>
(Supprimer), puis sur le bouton [Sélection].
= Une fenétre de confirmation apparait.

6. Appuyez légerement sur le bouton [Gauche, Droite] pour sélectionner
<Yes> (Oui), puis sur le bouton [Sélection].
= Le fichier sélectionné est supprimé.

A = Une fois supprimés, les fichiers ne peuvent plus étre récupérés.
ATTENTION

rg = Le fichier en cours de lecture ne peut pas étre supprimé.

REMARQUE <My Pack> (Mon pack) sous <File Browser> (Dossier Navigateur) est le dossier

dans lequel sont stockés les fichiers DNSe transférés via <EmoDio>. Pour obtenir
plus d’informations sur DNSe, reportez-vous a <EmoDio>.
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MODIFICATION DES REGLAGES ET DES PREFERENCES

Votre lecteur MP3 comprend des réglages et des préférences définis par défaut,
mais vous pouvez les modifier selon votre godt afin de personnaliser votre lecteur.
@ = Appuyez légérement sur [ ] pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [© ] pour accéder a I'écran du menu principal.
Réglages du style du menu
Vous pouvez modifier 'aspect et la police du menu et supprimer I'image
de fond d’écran du menu principal.
1. Appuyez longuement sur [ ] pour accéder a
I’écran du menu principal.
2. Appuyez légérement sur le bouton [Haut, Bas,

: " o427pM @@
Settings

Gauche, Droite] pour sélectionner <Settings> Ef’s‘:)’::
(Parameétres), puis sur le bouton [Sélection]. Languzge
= Le menu <Settings> (Paramétres) s’affiche. Date&Time

3. Appuyez légérement sur le bouton [Haut, Bas] System
pour sélectionner <Menu Style> (Style du menu),
puis sur le bouton [Sélection].
= Le menu <Menu Style> (Style du menu) s’affiche.

4. Les boutons [Haut, Bas] et [Sélection] servent a régler les fonctions.
= Appuyez légérement sur le bouton [Sélection] pour passer a I'élément

suivant ou sélectionner le menu.
= Appuyez légérement sur le bouton [Haut, Bas] pour monter ou descendre
dans le menu actuel.

Options de réglage du style du menu

= Menu Design (Aspect du menu) : Vous pouvez modifier le style de I'écran du
menu principal. Choisissez entre <Matrix> (Matrice) et <My Skin> (Mon habillage).

= Font (Police) : Vous pouvez modifier le type de police du menu. 3 types de police
sont proposés. |l est possible que pour certaines langues de menu, I'option <Font>
(Police) soit désactivée.

= Reset My Skin (Réinitialiser mon habillage) : Permet d'initialiser 'image de fond de
I'écran tactile par 'image par défaut.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglages du son

Vous pouvez régler I'égaliseur principal, le signal sonore et I'intensité du
volume sonore.

1. Appuyez longuement sur [©] pour accéder a Q cazrou @
I’écran du menu principal. P Seftings

2. Appuyez légérement sur le bouton [Haut, Bas, LH S'ylf
Gauche, Droite] pour sélectionner <Settings> Display SRS
(Paramétres), puis sur le bouton [Sélection]. Language

Date&Time
System

= Le menu <Settings> (Paramétres) s’affiche.

3. Appuyez légérement sur le bouton [Haut, Bas] pou
sélectionner <Sound> (Son), puis sur le bouton
[Sélection].
= Le menu <Sound> (Son) s’affiche.

4. Les boutons [Haut, Bas] et [Sélection] servent a régler les fonctions.

Options de réglage du son

Master EQ (EG princ.) : Vous pouvez optimiser les réglages du son. Appuyez
légerement sur le bouton [Gauche, Droite] pour sélectionner la fréquence que
vous souhaitez paramétrer. Appuyez légérement sur le bouton [Haut, Bas] pour
régler le niveau de la fréquence sélectionnée, puis sur le bouton [Sélection].

Beep Sound (Signal sonore) : Permet d’activer ou de désactiver I'émission d’un
signal sonore lors des opérations effectuées sur I'écran tactile. Choisissez entre
<Off> (Arrét) et <On> (Marche).

Volume Limit (Limitation du Volume) : Vous pouvez éviter I'apparition de troubles
auditifs en réglant I'intensité du volume sonore lors de I'utilisation des écouteurs.
I'option <On> (Marche) fixe le niveau maximal du volume a 15. Le niveau
maximal du volume lorsque la limite est réglée sur <Off> (Arrét) est de 30. Méme
si vous avez sélectionné <Off> (Arrét), le volume reviendra au niveau 15 lorsque
vous rallumerez le lecteur afin de vous éviter toute lésion du systeme auditif.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglage de I'affichage

Modifiez I'heure d’arrét de I'affichage et la luminosité de votre écran.

1. Appuyez longuement sur [ ] pour accéder & Q=
I’écran du menu principal. N Sefings
FPY Menu Style
2. Appuyez légerement sur le bouton [Haut, Bas, souy
Gauche, Droite] pour sélectionner <Settings> -
(Parametres), puis sur le bouton [Sélection]. Language

= Le menu <Settings> (Paramétres) s’affiche. Dete

System

3. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <Display> (Afficher), puis sur le
bouton [Sélection].

= Le menu <Display> (Afficher) s’affiche.

4. Les boutons [Haut, Bas] et [Sélection] servent a régler les fonctions.

Options de réglage de I’affichage

= Display Off (Affich. Désactivé) : Si aucun nombre n’est entré pour la sélection
de la période, I'écran s’éteint automatiquement. Vous pouvez choisir entre
<15sec>, <30sec>, <1min>, <3min>, <5min>, et <Always On> (Toujours
allumé). Pour rallumer I'écran, il vous suffit d’appuyer sur n'importe quel bouton.

= Brightness (Luminosité) : Permet de régler la luminosité de I'écran d’affichage.
Sélectionnez un niveau <0-10>, ou 10 est le plus lumineux.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglages de la langue

De nombreuses langues sont disponibles pour I'affichage des menus
de votre nouveau lecteur MP3. Vous pouvez changer facilement de
préférence de langue.

1. Appuyez longuement sur [ ] pour accéder a Q;emngs e
I'écran du menu principal. MenuStle
2. Appuyez légérement sur le bouton [Haut, Bas, ;f’“’l“‘
Gauche, Droite] pour sélectionner <Settings> oy
(Paramétres), puis sur le bouton [Sélection]. Datea T
= Le menu <Settings> (Parametres) s’affiche. System

3. Appuyez Iégérement sur le bouton [Haut, Bas]
pour sélectionner <Language> (Langue), puis sur le
bouton [Sélection].

La liste <Language> (Langue) s’affiche.

<English>, <8t= 01>, <Frangais>, <Deutsch>, <ltaliano>, < B 435> <{&{kH 3>,

<EpEh 7>, <Espariol>, <Pycckuit>, <Magyar>, <Nederlands>, <Polski>,

<Portugués>, <Svenska>, <'lng>, <Cestina>, <EAAnvika>, <Tirkge>, <Norsk>,
<Dansk>, <Suomi>, <Espafiol (Sudamérica)>, <Portugués (Brasil)>, <Indonesia>,
<Tiéng Viét>, <Bulgarian>, <Romana>, <YkpaiHcska>, <Slovenstina> et
<Slovensky>.

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner la
langue de votre choix, puis sur le bouton [Sélection].

'»g = Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglages de la date et I’heure

Réglez la date et I'heure actuelle.

1.

2.

. Appuyez légérement sur le bouton [Haut, Bas]

Appuyez longuement sur [ ] pour accéder a & . cazzpuam
I’écran du menu principal. Settings

L. Menu Style
Appuyez légerement sur le bouton [Haut, Bas, ol
Gauche, Droite] pour sélectionner <Settings> Display
(Parameétres), puis sur le bouton [Sélection]. Language

b

= Le menu <Settings> (Parametres) s’affiche.

d
System

pour sélectionner <Date&Time> (Date et heure),
puis sur le bouton [Sélection].

= L’écran Time Set (Réglage heure) s’affiche.

. Appuyez légérement sur le bouton [Haut, Bas] pour accéder

respectivement a <YEAR, MONTH, DATE, HOUR, MIN, AM/PM>
(Année, Mois, Jour, Heure, Minute, AM/PM) puis appuyez légérement
sur le bouton [Haut, Bas] pour régler chaque élément séparément.

. Appuyez légérement sur le bouton [Sélection].

= La fenétre de confirmation d’enregistrement apparait.

. Appuyez légérement sur le bouton [Gauche, Droite] pour

sélectionner <Yes> (Oui), puis sur le bouton [Sélection].
= L’heure et la date sont enregistrées.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglages du systéme

Sélectionnez le mode Veille, Début, Extinction auto ou Réglage par
défaut adapté.

1. Appuyez longuement sur [©] pour accéder a . oszromam
I’écran du menu principal. QSemngs

2. Appuyez légérement sur le bouton [Haut, Bas, ':j::ds‘y'e
Gauche, Droite] pour sélectionner <Settings> Display
(Paramétres), puis sur le bouton [Sélection].

Language
= Le menu <Settings> (Paramétres) s’affiche. Date&Time

3. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <System> (Systéme), puis sur le
bouton [Sélection].

= Le menu <System> (Systeme) s’affiche.

4. Les boutons [Haut, Bas] et [Sélection] servent a régler les fonctions.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Options de réglage du systéme

My Profile (Mon profil) : Vous permet de saisir votre nom et votre date de naissance.
Reportez-vous aux pages 30~31.

Sleep (Veille) : Permet d'éteindre automatiquement I'appareil aprés I'écoulement de

la durée préréglée. Options disponibles : <Off> (Arrét), <15min>, <30min>, <60min>,
<90min> ou <120min>.

Start Mode (Mode Début) : Permet de définir I'écran de démarrage affiché lors de la mise
sous tension du lecteur. Choisissez entre <Main Menu> (Menu Principal) et <Last State>
(Dernier Etat). Sélectionnez <Main Menu> (Menu Principal) pour démarrer le systeme avec
I'écran du menu principal et <Last State> (Dernier Etat) pour afficher 'écran du dernier
menu utilisé.

Auto Power Off (Extinction auto) : Permet d'éteindre automatiquement I'appareil
lorsque celui-ci est en mode Pause et qu'aucun bouton n’est actionné avant I'écoulement
de la durée prédéfinie. Choisissez entre <15sec>, <30sec>, <1min>, <3min>, <5min> et
<Always On> (Toujours allumé).

Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage par défaut.
Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) vous permet de réinitialiser
I'appareil sur les réglages par défaut. <No> (Non) permet d’annuler les réglages par défaut.
Format (Formater) : Vous permet de formater la mémoire interne. Options disponibles

: <Yes> (Oui) ou <No> (Non). Le réglage sur <Yes> (Oui) formate la mémoire interne et
supprime tous les fichiers du lecteur. En revanche, <No> (Non) ne lance pas le formatage
de la mémoire interne. vérifiez avant de lancer le formatage.

About (A propos de) : Appuyez légerement sur le bouton [Gauche, Droite] pour consulter
les informations relatives a la version du micrologiciel, a la capacité de la mémoire et au
numeéro de fichier.

<Firmware Version> (Version du firmware) affiche la version actuelle du micrologiciel.
<Used> (Utilisé) indique la capacité de mémoire actuellement utilisée, <Available>
(Disponible) la capacité restante de la mémoire et <Total> la capacité totale de la mémoire.
<Files> (Fichiers) permet de consulter le nombre de fichiers musicaux, de vidéos,
d'images, de textes ainsi que le nombre total de fichiers.

Demo Mode (Mode Démo) : Si vous le réglez sur <On> (Marche), le lecteur répéte la
lecture du clip stocké sur le dossier vidéo. Appuyez légerement sur le bouton tactile pour
revenir a I'écran précédent.

'.g = A propos de la mémoire intégrée
remaraue 1 G0=1,000,000,000 octets : la capacité réelle formatée peut étre inférieure,

car le micrologiciel interne en utilise une partie. )
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglage du nom

1. Appuyez [égérement sur le bouton [Haut, Bas]

L] 04:27PM @
pour sélectionner <My Profile> (Mon profil) puis sur M

le bouton [Sélection]. =
Ke¥al ABC | DEF

2. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <My Name> (Mon nom) puis sur
le bouton [Sélection].
= La fenétre Rename My Name (Renom. Mon nom)

apparait.

GHI | JKL |MNO
PRS | TUV | WXY
- e OK

B :teAca

3. Utilisez les boutons [Haut, Bas, Gauche, Droite] et [Sélection] pour
renommer I'appareil.

= [ [Ell ] : Le mode de saisie passe de Lettres majuscules a Lettres
minuscules et Chiffre.

= [ B3 1 : Vous permet de supprimer les caractéres I'un aprés 'autre.
= [l 1 : Vous permet d'insérer « — ».
= [[E3 1 : Vous permet de confirmer votre modification.

= Lorsque le réglage de nom est terminé, votre nom s’affiche lorsque vous
allumez le lecteur.
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)

Réglage Mon anniversaire

= Avant de démarrer - Vous devez tout d’abord régler I'horloge.
Reportez-vous a la page 27.

1. Appuyez légérement sur le bouton [Haut, Bas] Q wszromEm
pour sélectionner <My Profile> (Mon profil) puis sur [aafsTUALLESSES
le bouton [Sélection]. YEAR  MONTH  DATE

2. Appuyez légérement sur le bouton [Haut, m il 01
Bas] pour sélectionner <My Birthday> (Mon
anniversaire) puis sur le bouton [Sélection].

= La fenétre Edit My Birthday (Editer Mon anniversaire)
apparait.

3. Appuyez légérement sur le bouton [Gauche, Droite] pour accéder
respectivement a <YEAR, MONTH, DATE> (Année, Mois, Date) et
appuyez légérement sur le bouton [Haut, Bas] pour régler chaque
élément séparément.

4. Appuyez légérement sur le bouton [Sélection].

= Lorsque le réglage de la date de naissance est terminé, votre anniversaire
vous est rappelé lors de la mise sous tension du lecteur.
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REINITIALISATION DU SYSTEME

Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fichier ou n’est
pas reconnu par votre ordinateur lorsque vous le branchez, il est préférable de
réinitialiser le systéme.

Appuyez sur le bouton de réinitialisation

situé sur la partie inférieure de I'appareil a

I'aide d'un objet pointu, comme une agrafe.

= Le systéme est réinitialisé.

= |a fonction Reset (Réinitialisation) ne permet
pas de supprimer les renseignements de durée

et les données enregistrées dans la mémoire
intégrée.

A = Veillez a ne pas appuyer sur I'orifice du microphone a I'aide d’un objet pointu pour
ATENTION e pas endommager le produit.

32 _ fonctions de base



—MobIo

EmoDio est une application logicielle fournie avec ce lecteur MP3 qui
est destinée a la prise en charge de divers services aux contenus et
de différents supports de périphérique.

CONFIGURATION REQUISE

Votre ordinateur doit étre conforme a la configuration minimale requise suivante
pour que vous puissiez installer et exécuter EmoDio :

¢ Pentium 500 MHz ou plus e Lecteur de CD-Rom (2X ou plus)
e Port USB 2.0 * Windows Media Player 10 ou
¢ Windows XP Service Pack 2 ou ultérieur

ultérieur ¢ Résolution 1024 X 768 ou plus
* DirectX 9.0 ou version ultérieure * Internet Explorer 6.0 ou version

, . . ultérieure

* 100 Mo d’espace libre sur le disque

dur ¢ Mémoire vive 512 Mo ou plus

= Ne débranchez jamais le cable USB durant le transfert de fichiers ; vous risqueriez
arrenton  d’endommager le lecteur ou l'ordinateur.

= Branchez le lecteur directement sur I'ordinateur plutét que sur un Hub USB afin
d’éviter une mauvaise connexion.
= Toutes les fonctions sont désactivées durant le branchement.

REMARQUE w Utilisez le systéme de fichiers FAT 32 pour le formatage du lecteur sur votre
ordinateur.Sous Windows Vista, cliquez sur « Restore device defaults » (Restaurer
les paramétres par défaut du périphérique) et formatez-le.
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INSTALLATION D’EMODIO

= Assurez-vous que le programme d’installation <EmoDio>> a été lancé a partir
armenmon du compte administrateur de votre ordinateur. Dans le cas contraire, <EmoDio>
ne pourra pas étre installé. Pour trouver le compte administrateur, veuillez vous
reporter au manuel d’utilisation de votre

ordinateur.
SAMSUNG [
1. Insérez le CD d’installation fourni avec
I'appareil dans le lecteur de CD-ROM
de votre ordinateur. it
I oo 0 ssin i s wsores

2. Cliquez sur <Install now> (Installer
maintenant).

= Suivez les instructions pour démarrer I'installation.

= l'installation de <EmoDio> démarre et une icdne 53 s’affiche sur votre Bureau
lorsque celle-ci est terminée.

A = N'effectuez pas de mouvements brusques lorsque vous utilisez un CD-ROM installé
ATTENTION 3 |a verticale pour le chargement/le retrait du CD d’installation.

= La technologie de reconnaissance musicale et les données relatives sont fournies
remaraue  par Gracenote et Gracenote CDDB® Music Recognition ServiceSM.

= CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote,
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB»
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont
des marques de service de Gracenote.
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UTILISATION D’EMODIO

L’application logicielle EmoDio est facile a utiliser et vous permet de classer
vos fichiers sur votre ordinateur. Une fois vos fichiers classés et organisés dans
EmoDio, vous pouvez les transférer rapidement vers votre lecteur MP3 sans
avoir a faire des recherches sur 'ensemble de votre disque dur pour retrouver
le bon fichier.

@E Le programme <EmoDio> est le moyen le plus simple de transmettre
des fichiers de votre ordinateur vers votre lecteur MP3.
My PC
? Grace a <EmoDio>, vous créez votre propre collection ou liste de
e lecture ainsi que vos fichiers audio originaux.

Playlists

% Vous pouvez transférer vers le lecteur les informations relatives au
* blog et les fichiers enregistrés au format RSS.
Datacasts
Il s’agit d’'un service communautaire en ligne a l'intention des
@o utilisateurs d’EmoDio.com. Il offre une méthode simple et facile de
charger et télécharger des contenus produits a I'aide d’EmoDio et
des moyens permettant d’échanger vos expériences avec d’autres
utilisateurs de la communauté.

= Pour plus d'informations sur <EmoDio>, cliquez sur <MENU> — <Help> (Aide) —
remarque  <Help> (Aide) en haut du programme <EmoDio>.

EmoDio.com
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= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
rg = Appuyez légérement sur [ © ] pour aller a I'écran précédent.
remque  APpuyez longuement sur [ ] pour accéder a I'écran du menu principal.

LECTURE PAR CATEGORIE

nl 04:27PM @
J‘j @ N Music

MUSIC  VIDEOS  PICTURES

a Y Artists
é @ *\ Albums

5.
Music /!

2 NORMAL

TEXTS  FMAADIO DATACASTS

Songs

ﬁlﬁ rd Q Genres

i Playlists
PRIME PACK gpblken  SETTINGS

Recorded Files

06:46m Music Browser

1. Appuyez longuement sur [ ] pour accéder a I'écran du menu principal.

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, Droite] pour
sélectionner <Music> (Musique), puis sur le bouton [Sélection].
= La liste <Music> <Musique> s’affiche.

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner la liste
souhaitée, puis sur le bouton [Sélection].
= Le fichier musical s’affiche.

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le fichier a
lire, puis sur le bouton [Sélection].
= La lecture du fichier musical démarre.
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LECTURE PAR CATEGORIE (Suite)

Liste de fichiers musicaux

Les informations sur le fichier comprenant le nom de I'artiste, le nom de I'album, le titre de la
plage et le genre s’affichent en fonction des informations figurant sur I'étiquette ID3 du fichier
musical correspondant. Un fichier sans étiquette ID3 s’affiche comme [Unknown] (inconnu).
Now Playing (En lecture) : Permet de lire le fichier lu en dernier ou d’afficher I'écran de
lecture du fichier en cours.

Artists (Artiste) : Lecture par artiste

Albums : Lecture par album. Appuyez légérement sur [ [ ] pour sélectionner <List Type>
(Type de liste). Sélectionnez <Album Art> (Image CD) pour afficher simultanément la
jaquette du CD et le titre de I'album ou <List> (Liste) pour visionner uniquement le titre de
I'album.

Songs (Chansons) : Lecture en ordre numérique ou alphabétique

Genres : Lecture par genre

Playlists (Listes de lecture) : Lecture par liste

Recorded Files (Fichiers Enregistrés) : Affiche tous les fichiers enregistrés.

Music Browser (Navig. musique) : Permet d’afficher tous les fichiers musicaux enregistrés
dans le dossier musical.

= Les fichiers musicaux MP3 et WMA sont compatibles avec ce lecteur.
Les fichiers MP1 ou MP2 possédant uniquement une extension modifiée vers MP3
peuvent ne pas étre lus.
= Si vous débranchez les écouteurs pendant la lecture des données musicales, la
lecture s'interrompt.
= Qu’est-ce que I'étiquette ID3 ?
Il s’agit d’'un élément attaché a un fichier MP3 contenant les informations relatives au
fichier telles que le titre, l'artiste, 'album, 'année, le genre et un champ commentaire.

[l
REMARQUE
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PAUSE

1. Appuyez légerement sur le bouton [Sélection] lorsque la lecture de la
musique est en cours.

= La lecture de la musique est interrompue.
2. Appuyez légérement a nouveau sur le bouton [Sélection].
= La lecture reprend a I'endroit ou vous 'avez suspendue.

RECHERCHE A L'INTERIEUR D’UNE PLAGE

1. Appuyez longuement sur le bouton [Gauche, Droite] pendant que la plage
sélectionnée est en cours de lecture.
= Ces boutons permettent d’effectuer la recherche vers le début ou la fin de la plage.
2. Relachez le bouton dés que vous souhaitez reprendre la lecture.
= La lecture commence dés que vous relachez le bouton.

LECTURE DE LA PLAGE EN COURS A PARTIR DU DEBUT

Appuyez légerement sur le bouton [Gauche] apres 3 secondes de lecture.
= La plage en cours est lue a partir du début.

LECTURE DE LA PLAGE PRECEDENTE

Appuyez légérement sur le bouton [Gauche] dans les 3 premieres secondes de
lecture.
Appuyez deux fois sur le bouton [Gauche] aprés 3 secondes de lecture.
= La lecture de la plage précédente démarre.
= Pendant la lecture de fichiers VBR (débit binaire variable), la plage précédente

peut ne pas étre lue méme si vous appuyez sur le bouton [Gauche] au cours des 3
premiéres secondes de lecture.

LECTURE DE LA PLAGE SUIVANTE

Appuyez légérement sur le bouton [Droite].
= La lecture de la plage suivante démarre.
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE
LECTEUR MP3

Si vous avez déja téléchargé des fichiers sur votre lecteur MP3, vous pourrez
créer une liste de lecture de « Favoris ».

1. Appuyez longuement sur [ © ] pour accéder a I'écran du
menu principal.

2. Appuyez légerement sur le bouton [Haut, Bas, Gauche, AMylove
Droite] pour sélectionner <File Browser> (Dossier P
Navigateur), puis sur le bouton [Sélection]. Delete

3. Appuyez légérement sur le bouton [Haut, Bas] pour
sélectionner <Music> (Musique), puis sur le bouton
[Sélection].
= Le(s) fichier(s) musical/musicaux s’affiche(nt).

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner un fichier a
ajouter a la liste de lecture, puis sur [ B 1.
= Le menu de la liste de lecture apparait.

5. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner <Add to
Playlist> (A|. a liste lect.), puis sur le bouton [Sélection].
= <Playlist 1> (List lect 1) a <Playlist 5> (List lect 5) apparait.

6. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner un numéro
de liste de lecture pour ajouter le fichier sélectionné, puis sur le bouton
[Sélection].
= Le fichier sélectionné est ajouté a la liste de lecture.

= Vérifiez la liste de lecture dans <Music> (Musique) — <Playlists> (Listes de lecture) —
<Playlist 1> (List lect 1) a <Playlist 5> (List lect 5) dans le menu principal.
(/] = Vous pouvez ajouter jusqu'a 100 fichiers musicaux dans chaque liste de lecture
remaraue (<Playlist 1> (List lect 1) a <Playlist 5> (List lect 5)).
= Pour obtenir les informations sur la création d’une liste de lecture dans <EmoDio>
et son transfert vers votre lecteur, reportez-vous a <EmoDio>.
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LECTURE D’UNE LISTE DE LECTURE

1. Appuyez longuement sur [© ] pour accéder a I'écran du o oazrpuEm
menu principal. Music

Y Now Playing
2. Appuyez légerement sur le bouton [Haut, Bas, Gauche, Artists
Droite] pour sélectionner <Music> (Musique), puis sur le Albums
bouton [Sélection]. Songs

. . ) - Genres
= La liste <Music> <Musique> s’affiche.

Recorded” Files
Music Browser

3. Appuyez légérement sur le bouton [Haut, Bas] pour
sélectionner <Playlists> (Playlist), puis sur le bouton
[Sélection].
= Lalles liste(s) de lecture s'affiche(nt).

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner la liste de
lecture de votre choix, puis sur le bouton [Sélection].

= Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée apparaissent.

= Si vous ne trouvez aucune liste de lecture, le message
<No file.> (Aucun fichier.) s’affiche a I'écran.

5. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner le fichier
musical a lire, puis sur le bouton [Sélection].

= La lecture du fichier musical démarre.
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SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE

1. Appuyez longuement sur [ © ] pour accéder a I'écran du menu IR e
principal. @9 Paylists

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, Droite] e

. N . . . Playlist 2
pour sélectionner <Music> (Musique), puis sur le bouton Playlist 3
[Sélection]. Playlist 4
= La liste <Music> <Musique> s'affiche. Playlist 5

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner
<Playlists> (Playlist), puis sur le bouton [Sélection].
= LalLes liste(s) de lecture s'affiche(nt).

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner [F=1
la liste de lecture de votre choix, puis sur le bouton [Sélection]. ElayIst
= Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée

apparaissent.

5. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner  |isnstiliciut
un fichier a supprimer de la liste de lecture, puis sur [ E].
= Le menu de la liste de lecture apparait.

6. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner
<Delete from Playlist> (Suppr. de liste lect.), puis sur le bouton
[Sélection].
= Le fichier sélectionné est supprimé de la liste de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE LECTURE

Suivez les étapes 1 a 4 ci-dessus.
5. Appuyez légérement sur [ E].
= Le menu de la liste de lecture apparait.
6. Appuyez légérement sur le bouton [Haut, Bas] pour P
sélectionner <Delete All from Playlist> (Suppr. tt de liste lect.), Delete Al from Playlist
puis sur le bouton [Sélection].
= Tous les fichiers sont supprimés de la liste de lecture.

[.g = Le fichier sélectionné dans la liste de lecture ne peut pas étre
reMARQuE  SUPPrimé en cours de lecture.

My love

Playlist 1

My love
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UTILISATION DU MENU MUSIQUE

Le menu Musique vous permet de gérer toutes les facettes de I'écoute (de la
sélection des plages et des playlists au choix du fond d’écran durant I'écoute).

Régler I'effet sonore

Profitez d’'une qualité de son plus nette.

1. Appuyez légérement sur [ E)] tout en écoutant de la
musique.

= Le menu <Music> (Musique) s’affiche.

2. Appuyez légerement sur le bouton [Haut, g‘,’j‘s": Effect
Bas] pour sélectionner <Sound Effect> (Effets Play Mode
Sonores), puis sur le bouton [Sélection]. g“giicsg‘:eyfc"ee"
= Le menu <Sound Effect> (Effets Sonores) s’affiche. Skip Interval

Repeat A-B Mode On

3. Appuyez légerement sur le bouton [Haut,
Bas] pour sélectionner I'effet sonore souhaité, puis sur le bouton
[Sélection].

= Choisissez entre <Street Mode> (Mode Rue) et <Audio Upscaler> (Mise a
I'échelle audio).

Options d’effet sonore

= Street Mode (Mode Rue) : Permet d’écouter clairement en extérieur grace au
filtrage de certains bruits de la rue. Sélectionnez une valeur de 0 a 2.

= Audio Upscaler (Mise a I’échelle audio) : Cette fonction restitue presque
a l'original les sons sources perdus par encodage WMA/MP3. L'option Audio
Upscaler (Mise a I'échelle audio) fonctionne uniquement sur des fichiers
musicaux de piétre qualité. Sélectionnez <Off> (Arrét) ou <On> (Marche).

[,g = Pour quitter le menu, appuyez légerement sur [ 5]
REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)

Régler la fonction Digital Natural Sound engine (DNSe)

Vous permet de choisir le type de son convenant le mieux a chaque
genre musical.

1.

. Appuyez légérement sur le bouton [Haut, Bas]

. Appuyez légerement sur le bouton [Haut, Bas]

Appuyez légérement sur [ B] tout en écoutant de la
musique.

= Le menu <Music> (Musique) s’affiche.

Sound Effect

DNSe

pour sélectionner <DNSe>, puis sur le bouton Play Mode

2 = Music Play Screen
[Sélection]. e
= Le menu <DNSe> s'affiche. Skip Interval

RepeatA-B Mode On

pour sélectionner le DNSe de votre choix, puis sur le bouton

[Sélection].

= Choisissez entre <Auto>, <Normal>, <Studio>, <Rock>, <Classical>
(Classique), <Jazz>, <Ballad> (Ballade), <Club>, <Rhythm & Blues> (R&B),
<Dance> (Danse), <Café>, <Concert>, <Church> (Eglise ) et <myDNSe>.

= L'option <Auto> sélectionne automatiquement le mode DNSe correspondant
lorsque les informations relatives au genre musical sont indiquées sur
I'étiquette ID3 du fichier musical.

= La sélection de I'élément <myDNSe> permet de configurer I'option DNSe
utilisateur. Reportez-vous a la page 44.

rg = Qu’est-ce que la fonctionnalité DNSe ?
emaraue L@ technologie Digital Natural Sound Engine (DNSe) est une fonction

d’optimisation sonore congue par Samsung pour les lecteurs MP3. Cette
option offre différents réglages sonores visant a améliorer le type de musique
que vous écoutez.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner MonDNSe

Vous pouvez paramétrer un DNSE Utilisateur sur votre lecteur ou le
transférer a partir d'<EmoDio>.

1. Appuyez légérement sur [ E] tout en écoutant de la
musique.

= Le menu <Music> (Musique) s’affiche.

Rhythm & Blues

2. Appuyez légérement sur le bouton [Haut, Bas] Dance
pour sélectionner <DNSe>, puis sur le bouton o
[Sélection]. Church

v myDNSe

= Le menu <DNSe> s’affiche.

3. Appuyez légerement sur le bouton [Haut, Bas]
pour sélectionner <myDNSe>, puis sur le bouton [Sélection].

= La liste des DNSe utilisateur s’affiche.

4. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le
DNSe utilisateur de votre choix, puis sur le bouton [Sélection].
= L’élément User DNSe (DNSe utilisateur) sélectionné est ainsi défini.
= Vous pouvez régler <EQ> (EG), <3D & Bass>, <Concert Hall> (Salle
Concert) et <Clarity> (Netteté) lorsque I'élément <myDNSe> a été
sélectionné. Reportez-vous aux pages 45~48.

'Q = Pour les détails sur le réglage de I'option User DNSe (User DNSe) a I'aide
remarque de <EmoDio>, reportez-vous a <EmoDio>.

= || est possible de transférer vers le lecteur un total de 97 valeurs User
DNSe (DNSe utilisateur) a I'exception des valeurs comprises entre
<User 1> (Utilisateur 1) et <User 3> (Utilisateur 3).
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner MonDNSe (Suite)

<EQ> (EG)
Vous pouvez paramétrer les fréquences sonores individuellement selon vos
préférences.

1. Appuyez légérement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe
utilisateur de votre choix, puis sur [ @ ].
= La liste des DNSe utilisateur s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas]

Concert Hall

pour sélectionner <EQ> (EG), puis sur le bouton Clarity
[Sélection].

= L’écran de réglage <EQ> (EG) apparait.

3. Appuyez légéerement sur le bouton [Gauche, Droite] pour
sélectionner la fréquence que vous souhaitez régler, puis sur
le bouton [Haut, Bas] afin d’ajuster le niveau de la fréquence
sélectionnée.
= Vous pouvez régler le niveau de la fréquence sélectionnée de <—10 ~ +10>

<-10a +10>.

4. Appuyez légerement sur le bouton [Sélection].

= Le réglage est terminé.

lecture de fichiers musicaux _ 45



UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner MonDNSe (Suite)

<3D & BASS>
Vous pouvez régler le son ambiophonique 3D et le niveau d’amplification des
basses fréquences.

1. Appuyez légérement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe
utilisateur de votre choix, puis sur [ @ ].

= La liste des DNSe utilisateur s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas]

. N k Concert Hall
pour sélectionner <3D & Bass>, puis sur le Clarity

bouton [Sélection].

= L’écran de réglage <3D & BASS> apparait.

3. Appuyez légéerement sur le bouton [Gauche, Droite] pour
sélectionner <3D> (3D) ou <BASS>, puis sur le bouton [Haut, Bas].

= Vous pouvez sélectionner <0-4> pour les fonctions <3D> et <Bass>.

4. Appuyez légérement sur le bouton [Sélection].
= Le réglage est terminé.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner MonDNSe (Suite)

<Concert Hall> (Salle de concert)

Vous pouvez régler la taille et le niveau sonore de la salle de concert
comme si vous écoutiez de la musique dans une véritable salle de
concert.

1. Appuyez légérement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe
utilisateur de votre choix, puis sur [ @ ].

= La liste des DNSe utilisateur s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas]

. > Concert Hall
pour sélectionner <Concert Hall> (Salle de Clarity

concert), puis sur le bouton [Sélection].

= |’écran de réglage <Concert Hall>(Salle de concert)
apparait.

3. Appuyez légerement sur le bouton [Gauche, Droite] pour
sélectionner <Size> (Taille) ou <Level> (Niveau), puis sur le bouton
[Haut, Bas].

= Vous pouvez sélectionner une valeur comprise entre <0-3> pour les options
<Size> (Taille) et <Level> (Niveau).

4. Appuyez légérement sur le bouton [Sélection].
= Le réglage est terminé.

r,g = Selon le fichier musical, la sélection de <Concert Hall> (Salle de concert)
rewamque | Peut désactiver d’autres effets sonores.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner MonDNSe (Suite)

<Clarity> (Netteté)
Vous bénéficiez d’'un son plus clair et de meilleure qualité.

1. Appuyez légérement sur le bouton [Haut, Bas]
dans le menu myDNSe pour sélectionner le DNSe
utilisateur de votre choix, puis sur [ B ].

= La liste des DNSe utilisateur s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas]

Concert Hall

pour sélectionner <Clarity> (Netteté), puis sur le Clarity
bouton [Sélection].

= ’écran de réglage <Clarity> (Netteté) apparait.

= Vous pouvez sélectionner une valeur comprise entre <0-2>.

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le
niveau souhaité, puis sur le bouton [Sélection].

= Le réglage est terminé.
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UTILISATION DU MENU MUSIQUE (Suite)

Régler le mode de lecture

Permet de sélectionner le mode de lecture tel que les parametres de
répétition.
1. Appuyez légérement sur [ E] tout en écoutant de la
musique.
= Le menu <Music> (Musique) s’affiche.

Sound Effect

2. Appuyez légérement sur le bouton [Haut, Bas] DNSe
pour sélectionner <Play Mode> (Mode lecture), Play Mode
. - . Music Play Screen
puis sur le bouton [Sélection]. Play Speed
= Le menu <Play Mode> (Mode lecture) s’affiche. ;;‘ge‘gfi(_“;'mde ~

3. Appuyez légéerement sur le bouton [Haut, Bas]
pour sélectionner le mode lecture souhaité, puis sur le bouton
[Sélection].

Options du mode de lecture

= Normal : Permet de lire une fois tous les fichiers de la liste musicale actuelle
dans l'ordre.

= Repeat (Répéter) : Permet de répéter la lecture de tous les fichiers de la liste
musicale actuelle.

» Repeat One (Répéter 1X) : Permet de répéter la lecture d'un fichier.

= Shuffle (Aléatoire) : Permet de répéter la lecture de tous les fichiers de la liste
musicale actuelle de maniére aléatoire.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner I’écran de lecture musicale

Sélectionnez une image de fond d’écran parmi celles fournies ou
sélectionnez I'une de vos propres images a afficher lorsque vous écoutez
de la musique.

1. Appuyez légerement sur [ @] tout en écoutant de la

musique.
= Le menu <Music> (Musique) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] Sound Effect
pour sélectionner <Music Play Screen> (Ecran Py Node
Lect mus.), puis sur le bouton [Sélection]. Music Play Screen

X - Play Speed
= Le menu <Music Play Screen> (Ecran Lect mus.) s'affiche. | RISaCREL

Repeat A-B Mode On

3. Appuyez légerement sur le bouton [Gauche,
Droite] pour sélectionner I'écran de lecture
musicale de votre choix, puis sur le bouton [Sélection].

Options de I’écran de lecture musicale

= Faites votre choix parmi les options suivantes : <Reflection> (Réflexion), <Auto>
(Auto), <Passionate> (Passion), <Sweet> (Doux), <Quiet> (Calme), <Cheerful>
(Joie), <Album Art> (Image CD) et <Album Info> (Info.album).

= Auto : Change automatiquement les écrans de lecture musicale en fonction des
informations contenues sur I'étiquette ID3 du fichier musical.

= Album Art (Image CD) : L'image de la jaquette du CD s'affiche si une image de
jaquette figure dans les informations de I'étiquette ID3 du fichier musical. Les
images de la jaquette du CD d’une taille inférieure a 200 pixels (horizontal) x 200
pixels (vertical) sont prises en charge.

= Album Info. (Info.album) : Les informations concernant le nom de I'artiste, I'album
et le genre s’affichent si celles de I'étiquette ID3 sont enregistrées dans le fichier
musical.

= Qu’est-ce que I'étiquette ID3 ?
remaraue |1 S'agit d’un élément attaché a un fichier MP3 contenant les informations
relatives au fichier telles que le titre, I'artiste, I'alboum, 'année, le genre et un
champ commentaire.
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UTILISATION DU MENU MUSIQUE (Suite)

Régler la vitesse de lecture

Accélérez ou ralentissez votre musique préférée en réglant la vitesse de lecture.

1. Appuyez légérement sur [ B] tout en écoutant de la
musique.

= Le menu <Music> (Musique) s’affiche.

2. Appuyez légerement sur le bouton [Haut, Bas] Sound Effect
A i H DNSe
pour sélectionner <Play Speed> (Vitesse de Play Mode
lecture), puis sur le bouton [Sélection]. Musio Play Screen
ay Spee
= Le menu <Play Speed> (Vitesse de lecture) s’affiche. Skip Interval

Repeat A-B Mode On

3. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner la vitesse de lecture souhaitée, puis sur le bouton
[Sélection].
= Faites votre choix parmi les valeurs suivantes : <Slow3> (Lent3), <Slow2>

(Lent2), <Slow1> (Lent1), <Normal> (Normal), <Fast1> (Rapide1), <Fast2>
(Rapide2), <Fast3> (Rapide3).
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UTILISATION DU MENU MUSIQUE (Suite)

Régler I'intervalle de saut

Vous pouvez avancer rapidement dans un fichier a intervalles variés.
Sautez 'ensemble de la plage ou sautez plusieurs secondes a la fois.

1. Appuyez légérement sur [ E] tout en écoutant de la
musique.

= Le menu <Music> (Musique) s’affiche.

2. Appuyez légérement sur le bouton [Haut, gi‘usn: Effect
Bas] pour sélectionner <Skip Interval> (Saut Play Mode
Intervalle), puis sur le bouton [Sélection]. m:jcssivd&feen
= Le menu <Skip Interval> (Saut Intervalle) s’affiche. Skip Interval

Repeat A-B Mode On

3. Appuyez légerement sur le bouton [Haut, Bas]
pour sélectionner I'intervalle de saut souhaité, puis sur le bouton
[Sélection].
= Choisissez entre <1 Song> (1 chanson), <5sec>, <10sec>, <30sec> et

<1min>.

(/) = Sile fichier a été encodé avec un débit binaire variable (VBR), il se peut
remaraue - que la longueur réelle de l'intervalle de saut soit Iégérement différente de
celle que vous avez sélectionnée.
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UTILISATION DU MENU MUSIQUE (Suite)

Pour définir la répétition d’'un segment

Cette fonction vous permet d’écouter des parties spécifiques d’'une
plage de fagon répétée. Recommandée pour I'apprentissage d’'une
langue.

1. Appuyez légérement sur [ E ] a I'endroit voulu
pendant la lecture de la musique.
= Le menu <Music> (Musique) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] Sound Effect
pour sélectionner <Repeat A-B Mode On> (Mode g\’:ji/lode
Répéter A-B activé), puis sur le bouton [Sélection]. |RIEEE S
= L'écran de configuration des répétitions de segments :Eg Shee)

s’affiche. RepeatA-B Mode On

3. Appuyez légerement sur I'icone [ B ] au début de
la section que vous souhaitez répéter.
= Le point de départ est réglé et le symbole < ¥ > apparait dans la barre de
progression de la lecture.
4. Appuyez légérement a nouveau sur [ E ] pour définir la fin de la
section que vous souhaitez répéter.

= Le symbole < ¥ > apparait dans la barre de progression de la lecture et la
lecture répétée de la section spécifiée démarre.

Annulation de la répétition d’un segment

1. Appuyez légérement sur [©] pendant la répétition du segment.
= La répétition du segment est annulée.

r.g = La répétition du segment s’annule automatiquement dans le cas suivant :
remaraue - lorsque le début du segment a répéter est défini mais que la fin ne I'est
pas avant que la plage en cours ne se termine.
- Si le point de fin est spécifié sur une durée de lecture inférieure a 3

secondes a compter du point de début.
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= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la
batterie.

Transférez les fichiers vidéo vers le lecteur a I'aide de <EmoDio>.
{Q = Appuyez légérement sur [ ] pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [ 5] pour accéder a I'écran du menu principal.

REGARDER UNE VIDEO
1. Appuyez longuement sur [ ] pour accéder a I'écran du
menu principal. ip) Q 2 |
2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, 2T
Droite] pour sélectionner <Videos> (Vidéos), puis sur le é gﬂ *
bouton ISélection]_ TEXTS - CEUIBABIO\ DATACASTS
= La liste des <Videos> (vidéos) s'affiche. =.ﬁ | @ Q
3. Appuyez légérement sur le bouton [Haut, Bas] pour PR PACK prblien  SETTIGS
sélectionner la vidéo a lire, puis sur le bouton [Sélection]. 06:46em
= La lecture du fichier vidéo sélectionné démarre horizontalement.
Bouton [Haut, Bas] |
PAUSE '

1. Appuyez légerement sur le bouton
[Sélection] durant la lecture vidéo.
= Le lecteur met la lecture en pause.

2. Appuyez légérement a nouveau sur le

bouton [Sélection].
= Le lecteur reprend au dernier point de Bouton [Gauche, Droite]

lecture. <En affichage horizontal>
[Q = Avant de procéder au transfert du fichier vidéo vers le lecteur a l'aide de la fonction
remaraue <EmMoDio>, le fichier est tout d’abord converti automatiquement au format SVI. La
taille du fichier est également réglée automatiquement.

Pour obtenir plus d’'informations a ce sujet, reportez-vous a <EmoDio>.
54 _ regarder une vidéo




PASSER A UNE SEQUENCE SPECIFIQUE

1. En affichage horizontal, appuyez longuement sur le
bouton [Gauche, Droite].
= Cette option vous permet de reculer ou d’avancer dans le
fichier vidéo en cours.
2. Relachez le bouton une fois la position souhaitée
atteinte.
= La lecture de la vidéo démarre a partir de cette position.

LIRE LE FICHIER VIDEO PRECEDENT

Appuyez légérement sur le bouton [Gauche] dans les
3 secondes suivant le démarrage de la lecture du fichier
en cours.

Appuyez deux fois sur le bouton [Gauche] 3 secondes
aprés le démarrage de la lecture du fichier en cours.

= Cette opération permet de revenir a la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT

Appuyez légérement sur le bouton [Droite].
= Cette opération permet d’accéder au film suivant.
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UTILISATION DU MENU VIDEO

Réglage d'un signet

La définition d'un signet vous permet de retrouver facilement la position
correspondante ultérieurement.

1.

Appuyez sur [ @] pour afficher la scéne
souhaitée durant la lecture de la vidéo. :
= Le menu <Video> (Vidéo) s'affiche. A T

2. Appuyez légérement sur le bouton [Haut, Bas] | [Eeies
| DNSe

g

pour sélectionner <Add Bookmark> (Ajouter
signet), puis sur le bouton [Sélection].

= Le point de lecture/d'arrét courant est ajouté au signet.

= Le symbole [ | ] apparait dans la barre de progression de la lecture.

= La fenétre Réécrire apparait si un signet a déja été défini. Si vous sélectionnez

remarque < Yes> (Oui), le signet préalablement défini est supprimé et un nouveau signet est

ajouté.
= Un signet peut étre défini pour chaque fichier vidéo (50 signets au maximum).

Accéder a lire/Supprimer un signet

1.

Appuyez légérement sur [ E)] pendant la lecture
de la vidéo.
= Le menu <Video> (Vidéo) s'affiche.

Go to Bookmark

. Appuyez légérement sur le bouton [Haut, Bas] |Essdiausis

Brightness

pour sélectionner <Go to Bookmark> (Accéd. |BIEE

a Signet) ou <Delete Bookmark> (Supprimer |

signet), puis sur le bouton [Sélection].

= Lorsque vous avez sélectionné <Go to Bookmark> (Accéd. a Signet), le lecteur
accéde au signet sélectionné et commence la lecture.

= L'option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet
sélectionné du fichier vidéo.

7
fﬁ = Pour quitter le menu, appuyez légerement sur [ 3 ].

REMARQUE
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UTILISATION DU MENU VIDEO (Suite)

Régler la luminosité

Vous pouvez régler la luminosité de I'écran.

1. Appuyez légérement sur [ E] pendant la
lecture de la vidéo.
= Le menu <Video> (Vidéo) s'affiche.

2. Appuyez légérement sur le bouton [Haut,
Bas] pour sélectionner <Brightness>
(Luminosité), puis sur le bouton [Sélection].
= Le menu <Brightness> (Luminosité) s’affiche.

3. Appuyez légérement sur le bouton [Haut, Bas] pour spécifier le
degré de luminosité souhaité, puis sur le bouton [Sélection].
= Choisissez entre <0~10>.

Régler la fonction Digital Natural Sound engine (DNSe)

Permet de choisir le type de son convenant le mieux a chaque genre de vidéo.
1. Appuyez légérement sur [ E] pendant la
lecture de la vidéo.
= Le menu <Video> (Vidéo) s'affiche.
2. Appuyez légérement sur le bouton [Haut,

Brightness

Bas] pour sélectionner <DNSe>, puis sur le  |EisE
bouton [Sélection]. |
= Le menu <DNSe> s’affiche.

3. Appuyez légéerement sur le bouton [Haut, Bas] pour sélectionner le
DNSe de votre choix, puis sur le bouton [Sélection].
= Choisissez entre <Normal>, <Drama> (Drame) et <Action>.
r.g = Qu’est-ce que la fonctionnalité DNSe ?
remaraue L@ technologie Digital Natural Sound Engine (DNSe) est une fonction
d’optimisation du son congue par Samsung pour les lecteurs MP3. Cette
option offre différents réglages sonores visant a améliorer le type de musique
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= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
Transférez les fichiers image vers le lecteur a I'aide de <EmoDio>.
rg = Appuyez légérement sur [ © ] pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [ %5 | pour accéder a I'écran du menu principal.

AFFICHAGE DES IMAGES

1. Appuyez longuement sur [ ] pour accéder a I'écran du

menu principal. D

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, woE0S.  pioTURES
Droite] pour sélectionner <Pictures> (Images), puis sur le @ *‘\
bouton [Sélection]. HIARDIO oaTACAS
= La fenétre de prévisualisation apparait. r

3. Appuyez légérement sur le bouton [Haut, Bas, Gauche, -3

PRIME PACK gpblbE o SETTINGS

Droite] pour sélectionner 'image que vous souhaitez
visualiser, puis sur le bouton [Sélection].

06:46pm
= L'image sélectionnée s'affiche. Bouton [Haut, Bas]l—\

= Appuyez légerement su [ D | pour aller & la fenétre de
prévisualisation.

Accéder a I'image précédente/suivante

En affichage horizontal, appuyez légérement
sur le bouton [Gauche, Droite].

= L'image précédente/suivante s'affiche. |
@ = Avant le transfert du fichier image vers le lecteur a l'aide Bouton [Gauche, Droite] |_,
remaraue  dU logiciel <EmoDio>, celui-ci est tout d’abord converti
automatiquement au format JPG. La taille du fichier est
également réglée automatiquement. Pour obtenir plus d'informations a ce sujet, reportez-vous a
<EmoDio>.
= s'affiche lorsque les fichiers JPG comportent des données incorrectes au niveau des vignettes.
= Certaines images peuvent étre affichées lentement.
= \lous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour rechercher
une image. Reportez-vous a la page 21.
58 _ affichage des images

<En affichage horizontal>



UTILISATION DU MENU IMAGE
Ecouter de la musique ou la radio FM durant
I'affichage des images

Vous pouvez godter au plaisir d’écouter de la musique ou la radio FM
tout en affichant vos images.

1. Appuyez légérement sur [ @] pendant

I'affichage de 'image.
. s e Music On
= |e menu <Picture> (Image) s'affiche. FM Radio On
L. Start Sildeshow
2. Appuyez légerement sur le bouton [Haut, Zoom)
Bas] pour sélectionner <Music On> Auto Pivot

Transition Effect

(Musique activée) ou <FM Radio On> (Radio |
FM activée) puis sur le bouton [Sélection]. -

= A chaque fois que vous appuyez légérement sur les options <Music On>
(Musique activée) ou <FM Radio On> (Radio FM activée), vous faites basculer
I'appareil entre activation et désactivation du son.

Visionner un diaporama

Marche a suivre 1

1. Appuyez légérement sur le bouton [Sélection] en
visionnant une image.
= Le symbole [] s’affiche a I'écran et le lecteur démarre vl | Ir..

le diaporama. “Start Sideshow

Marche a suivre 2

1. En mode de prévisualisation de I'image, appuyez
légérement sur [ E].

2. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <Start Slideshow> (Démarrer
diaporama), puis sur le bouton [Sélection].
= Le symbole [ () ] s'affiche & I'écran et le lecteur démarre le diaporama.

[Q = Pour quitter le menu, appuyez légérement sur [ E].
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UTILISATION DU MENU IMAGE (Suite)

Arrét du diaporama

Marche a suivre 1

1. En mode diaporama, appuyez légerement
sur le bouton [Sélection].

d
= Le diaporama s’arréte. Sl

Marche a suivre 2
1. En mode diaporama, appuyez légérement sur

[B]

= Le menu <Pictures> (Images) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner
<Stop Slideshow> (Arrét diaporama), puis sur le bouton [Sélection].

= Le diaporama s’arréte.

Régler la vitesse du diaporama

1. En mode diaporama, appuyez légérement
sur[E]. -
Stop Sildeshow

= Le menu du diaporama apparait. Slideshow Speed
Transition Effect

2. Appuyez légerement sur le bouton [Haut,
Bas] pour sélectionner <Slideshow Speed>
(Vitesse diaporama), puis sur le bouton
[Sélection].
= Le menu <Slideshow Speed> (Vitesse diaporama) s’affiche.

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner la
vitesse souhaitée, puis sur le bouton [Sélection].
= Choisissez entre <Fast> (Rapide), <Normal> et <Slow> (Lent).
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UTILISATION DU MENU IMAGE (Suite)

Agrandir une image

\ous pouvez zoomer sur une image.
1. Appuyez légérement sur [ ] pendant
I'affichage de 'image.

“Music On

= Le menu <Pictures> (Images) s’affiche. FM Radio On
Start Sildeshow
2. Appuyez légérement sur le bouton [Haut, 2
Bas] pour sélectionner <Zoom> (Zoom), Aulo Pl
ransition Effect

puis sur le bouton [Sélection]. selectashysiin
= Le menu <Zoom> s'affiche.

3. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner le
niveau de zoom souhaité puis sur le bouton [Sélection].

= Choisissez entre <100%>, <200%> et <400%>.

4. Appuyez légerement sur le bouton [Haut, Bas, Gauche, Droite]
pour accéder a la partie de I'image que vous souhaitez agrandir.

Annuler le zoom

Appuyez légerement sur le bouton [Sélection] en visionnant une
image agrandie.
= Cette fonction permet de revenir a la taille initiale.

r,g = | 'agrandissement d’un fichier image volumineux peut prendre un certain
REMARQUE tE€MPS.
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UTILISATION DU MENU IMAGE (Suite)

Pour faire pivoter une image

Vous pouvez faire pivoter 'image selon vos envies.

1. Appuyez légerement sur [ @] pendant
I'affichage de I'image.

Music On

= Le menu <Pictures> (Images) s’affiche. FM Radio On
P Start Sildeshow
2. Appuyez légérement sur le bouton [Haut, Zoom
- . . tate
Bas] pour sélectionner <Rotate> (Pivoter), Auto Pivot
puis sur le bouton [Sélection]. L

= Le menu <Rotate> (Pivoter) s’affiche.

3. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner
I'angle souhaité, puis sur le bouton [Sélection].

= Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.
Régler la fonction Auto Pivot (Pivot automatique)

La fonction Pivot automatique fait tourner 'image proportionnellement
de sorte qu’elle s’affiche a I'écran selon la taille maximale possible.

1. Appuyez légérement sur [ ] pendant
I'affichage de I'image.
= Le menu <Pictures> (Images) s’affiche. R
2. Appuyez légérement sur le bouton [Haut, ety
Bas] pour sélectionner <Auto Pivot> (Pivot

i i & i Transition Effect
automatique), puis sur le bouton [Sélection]. Mo,

= Le menu <Auto Pivot> (Pivot automatique)
s’affiche.

3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner
<0On> (Marche), puis sur le bouton [Sélection].

= La fonction Pivot automatique est ainsi définie.
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UTILISATION DU MENU IMAGE (Suite)

Modifier I’effet de transition

Vous pouvez régler I'effet de transition de sorte a spécifier le

basculement de I'image actuelle sur 'image précédente ou suivante.

1. Appuyez légérement sur [ @] pendant
I'affichage de I'image.

= Le menu <Pictures> (Images) s’affiche. A\;Is#{cd‘o -
2. Appuyez légerement sur le bouton [Haut, [l
Bas] pour sélectionner <Transition Effect> Rotate
e . Auto Pivot
(Effet de transition), puis sur le bouton Transition Effect

Select as My Skin

[Sélection].
= Le menu <Transition Effect> (Effet de transition) s’affiche.
3. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner
I'effet de transition souhaité, puis sur le bouton [Sélection].
= Faites votre sélection parmi les options suivantes : <Off> (Désactivé), <Auto>
(Auto), <Cover> (Couvercle), <Fade> (Fondu), <Push> (Appuyer), <Split>
(Partagé), <Blinds> (Caches) et <Zoom> (Zoom).
Sélectionner une image comme fond d’écran

Vous pouvez définir 'image de votre choix comme fond d’écran.
1. Sélectionnez le fichier image a définir comme >
image de fond d'écran et appuyez légérement

o
sur [ E]] Fl\l;sll?cadlo On
= Le menu <Pictures> (Images) s’affiche. Start Sideshow
AQe Rotats
2. Appuyez légérement sur le bouton [Haut, Rotate

Bas] pour sélectionner <Select as My Skin> | Rz
. . . . Select as My Skin
(Sélectionner comme habillage), puis sur le =
bouton [Sélection].
= La fenétre de confirmation d’enregistrement apparait.
3. Appuyez Iégérement sur le bouton [Gauche, Droite] pour
sélectionner <Yes> (Oui), puis sur le bouton [Sélection].

= L'image sélectionnée est définie comme fond d'écran.
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lectuedetexte

Qu'il s'agisse d'un roman, d'un scénario ou d'un article, votre lecteur
MP3 vous permet de le lire tout en écoutant de la musique !

= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
Transférez les fichiers texte vers le lecteur a I'aide de <EmoDio>.
Réglez la langue de votre choix pour le texte. Reportez-vous a la page 69.
= Appuyez légérement sur [ © ] pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [ © ] pour accéder a I'écran du menu principal.

LECTURE DE TEXTE

1. Appuyez longuement sur [ ] pour accéder a I'écran du

menu principal. (A |
2. Appuyez légerement sur le bouton [Haut, Bas, Gauche, gl
Droite] pour sélectionner <Texts> (Textes), puis sur le @
bouton [Sélection].
= La liste des fichiers texte s'affiche. .a
3. Appuyez légérement sur le bouton [Haut, Bas] pour PRIME PACK gnisen  SETTINGS
sélectionner le fichier texte souhaité, puis sur le bouton 06:46m
[Sélection].

= Le texte s'affiche a I'écran.
= Appuyez longuement sur le bouton [Sélection] pour afficher le format plein I'écran
Pour revenir sur I'écran précédent, appuyez longuement a nouveau sur le bouton
[Sélection].
Accéder a la page précédente/suivante

Appuyez légérement sur le bouton [Gauche, Droite].

= Appuyez longuement sur le bouton [Gauche, Droite] pour accéder de maniére
continue a la page précédente/suivante.

= Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour
remaraue  echercher un fichier texte. Reportez-vous a la page 21.

= \otre lecteur MP3 prend en charge les fichiers au format TXT en mode Texte.
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UTILISATION DU MENU TEXTE

Ecouter de la musique ou la radio FM durant la
lecture de texte

Vous pouvez golter au plaisir d’écouter de la musique ou la radio FM
tout en lisant vos textes.
1. Appuyez légéerement sur [ ] pendant I'affichage du
texte.
= Le menu <Text> (Texte) s'affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] N —

pour sélectionner <Music On> (Musique activée) Go'to 1st Page

ou <FM Radio On> (Radio FM activée) puis sur le  [[[SSiesasis

bouton [Sélection]. :

. PO Text Viewer Color

= A chaque fois que vous appuyez légérement sur les Font Size
options <Music On> (Musique activée) ou <FM Radio
On> (Radio FM activée), vous faites basculer I'appareil entre activation et
désactivation du son.

Accéder a la premiére page

Utilisez cette fonction pour afficher le texte de la premiere page.
1. Appuyez légerement sur [ @] pendant I'affichage du texte.
= Le menu <Text> (Texte) s'affiche. @ .
Book1

2. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <Go to 1st page> (Aller a la 1ére

page), puis sur le bouton [Sélection]. wsécgno
adio On
= Une fenétre de confirmation s’affiche. Go'to 1st Page
POy Add Bookmark
3. Appuyez légerement sur le bouton [Gauche, Goto Bookm
Droite] pour sélectionner <Yes> (Oui), puis sur le  |ESEASRES
- A ext Viewer Color
bouton [Sélection]. Font Size

= Permet d’accéder a la premiére page.

[»ﬂ = Pour quitter le menu, appuyez légérement sur [ E].
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UTILISATION DU MENU TEXTE (Suite)
Réglage d'un signet

Définissez un signet pour revenir a tout moment a ce point du texte.

1. Appuyez légerement sur [ E] a la page voulue a:
pendant la consultation d'un texte. ool

= Le menu <Text> (Texte) s’affiche.
Music On

2. Appuyez légérement sur le bouton [Haut, Bas] FM Radio On
pour sélectionner <Add Bookmark> (Ajouter e
signet), puis sur le bouton [Sélection]. G

= L'écran du texte actuel est associé a un signet et le
symbole [2] s'affiche dans le coin supérieur gauche. Font Sizg

f/] =La fenétre Réécrire apparait si un signet a déja été
remaraue d€fini. Si vous sélectionnez <Yes> (Oui), le signet préalablement défini est
supprimé et un nouveau signet est ajouté.
= Un signet peut étre défini pour chaque fichier texte (50 signets au maximum).

Accés a/Suppression d’un signet

1. Appuyez légérement sur [ E)] pendant I'affichage du @ .
texte. Eookt

= Le menu <Text> (Texte) s’affiche.
Music On

2. Appuyez légérement sur le bouton [Haut, Bas] FM Radio On
pour sélectionner <Go to Bookmark> (Accéd. i
a Signet) ou <Delete Bookmark> (Supprimer Go to Bookmark
. . e M Delete Bookmark
signet), puis sur le bouton [Sélection]. T Cals

Font Size

= Vous accédez au signet sélectionné lorsque vous
cliquez sur <Go to Bookmark> (Accéd. a Signet) et le
supprimez du fichier texte lorsque vous sélectionnez <Delete Bookmark>
(Supprimer signet).
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UTILISATION DU MENU TEXTE (Suite)

Réglage de la couleur de la visionneuse de texte

Choisissez la couleur d’affichage du texte.

1. Appuyez légérement sur [ E)] pendant I'affichage du
texte.
= Le menu <Text> (Texte) s'affiche.

2. Appuyez légérement sur le bouton [Haut, Bas]

4w
8 5o

FM Radio On

pour sélectionner <Text Viewer Color> (Coul. Goto st Page

visionn. text), puis sur le bouton [Sélection]. fddBookmarc

= La fenétre du menu <Text Viewer Color> (Coul. visionn. | EEECEEMEE
text) apparait. Text Viewer Color

Font Size

3. Appuyez légérement sur le bouton [Gauche,
Droite] pour sélectionner la couleur de la visionneuse de texte
souhaitée, puis sur le bouton [Sélection].
= Sélectionnez I'une des options comprises entre <Type 1> et <Type 6>.

Modifier la taille de la police

Vous pouvez modifier la taille de la police utilisée dans le texte.
1. Appuyez légérement sur [ E] pendant I'affichage du

texte.
= Le menu <Text> (Texte) s'affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] -
pour sélectionner <Font Size> (Taille police), puis  JfREEEE
sur le bouton [Sélection]. e Sooknarc
[ i i i g D k

Le menu <Font Size> (Taille police) s’affiche. o

3. Appuyez légerement sur le bouton [Gauche, FontSizg

Droite] pour sélectionner la taille de police
souhaitée, puis sur le bouton [Sélection].
= Choisissez entre <Small> (Petit), <Medium> (Moyen) et <Large>.
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UTILISATION DU MENU TEXTE (Suite)

Régler le mode d’affichage du texte

Vous pouvez afficher le texte horizontalement ou verticalement.

1. Appuyez légerement sur [ E] pendant I'affichage du
texte.
= Le menu <Text> (Texte) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] YZ#ZIZS?

pour sélectionner <View Type> (Type d’affichage),
puis sur le bouton [Sélection].

= ’écran <View Type> (Type d’affichage) apparait.

3. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner le type d’'affichage souhaité, puis
sur le bouton [Sélection].

= Choisissez entre <Normal> (Normal) et <Horizontal> (Horizontal).

= Sélectionnez <Normal> (Normal) pour afficher le texte a la verticale et
<Horizontal> (Horizontal) pour faire pivoter le texte a I'horizontale.
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UTILISATION DU MENU TEXTE (Suite)

Régler la langue du texte

Vous pouvez sélectionner la langue du texte a afficher.

1. Appuyez légerement sur [ E] pendant I'affichage du
texte.
= Le menu <Text> (Texte) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] YSJ{,I!;’?

pour sélectionner <Language> (Langue), puis sur
le bouton [Sélection].

La liste <Language> (Langue) s’affiche.

<English>, <Korean>, <French>, <German>, <Italian>,
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>,
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>,
<Thai>, <Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>,
<Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>,
<Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish>, <Vietnamese>.

3. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner la
langue de votre choix, puis sur le bouton [Sélection].

= Vous pouvez afficher le texte dans la langue sélectionnée.

'Q = Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE
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UTILISATION DU MENU TEXTE (Suite)

Ecouter du TTS (Text to Speech) (Texte en Son)

Servez-vous de la fonction TTS (Texte en Son) de I'application
<EmoDio> afin de convertir un fichier de texte en un fichier TTS et
écouter celui-ci.

= Avant de démarrer - Transférez les fichiers TTS vers le lecteur a I'aide de
<EmoDio>.

1. Appuyez longuement sur [© ] pour accéder a I'écran du menu
principal.

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, Droite]
pour sélectionner <Texts> (Textes), puis sur le bouton [Sélection].
= La liste des fichiers TTS s’affiche.

3. Appuyez légerement sur le bouton [Haut, Bas] pour sélectionner un
fichier TTS téléchargé puis sur le bouton [Sélection].
= Vous pouvez ainsi écouter le fichier.

'.g = Vous pouvez régler la vitesse de lecture et I'intervalle de saut en appuyant
remamaue  1€g€rement sur [ E].

= Pour les détails sur la fonction TTS (Texte en Son) sous <EmoDio>,
reportez-vous a la <EmoDio>.
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ecouter laradio =\l
= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la

batterie.

= Appuyez légérement sur [ ] pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [ | pour accéder a I'écran du menu principal.

ECOUTER LA RADIO FM

1. Appuyez longuement sur [ © ] pour accéder a I'écran du )
menu principal. @ N

2. Tap the [Up, Down, Left, Right] button to select <FM
Radio> and tap the [Select] button.

2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, [ $
Droite] pour sélectionner <FM Radio> (Radio FM), puis s e ol
sur le bouton [Sélection]. snbiEen

06:46
= La réception de la radio FM est activée. i

POUR UTILISER LA FONCTION MUTE (SILENCE)

1. Appuyez légérement sur le bouton [Sélection] tout en écoutant la radio FM.
= Le son est désactive.

VIDEOS  PICTURES

B w

2. Appuyez légérement a nouveau sur le bouton [Sélection] pour reprendre
I'écoute.

Q = Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez des
RemARQUE  fréguences. N .
Les écouteurs sont utilisés comme antennes de réception des ondes FM.
= Dans les zones ou la qualité de réception est mauvaise, il se peut que le lecteur ne
détecte aucune fréquence FM.
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POUR RECHERCHER DES STATIONS DE RADIO FM

1. Appuyez longuement sur le bouton [Gauche, Droite] et
relachez en mode Manuel.

= La recherche s’arréte sur la fréquence la plus proche du point de
relachement du bouton.

ou,

1. Appuyez légerement sur le bouton [Gauche, Droite] pour
rechercher les fréquences une par une en mode Manuel.

= Change de fréquence a chaque nouvelle pression du bouton.
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UTILISATION DU MENU DE LA RADIO FM

Pour basculer vers le mode manuel

Sélectionnez ce mode si vous souhaitez effectuer une recherche
manuelle d’'une fréquence a la fois sur la bande FM.

1. Appuyez légérement sur [ E] en mode Manuel.
= Le menu <FM Radio> (Radio FM) s’affiche. =)

2. Appuyez légérement sur le bouton [Haut, Bas] s
pour sélectionner <Go to Preset Mode> (Aller au

mode pré-progr), puis sur le bouton [Sélection]. Pt
y . Auto Preset
= <Preset> s’affiche. Start Recording
FM Sensitivity
= Si aucune fréquence de présélection n’est définie, le FM Region

remarque  lecteur ne passe pas en mode Présélection.

Pour basculer vers le Mode présélection

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos
présélections FM une a la fois.

1. Appuyez légérement sur [ E] en mode Présélection.
= Le menu <FM Radio> (Radio FM) s’affiche.

2. Appuyez légérement sur le bouton [Haut, Bas] i
pour sélectionner <Go to Manual Mode> (Aller au  JEXEIEIELES

mode manuel), puis sur le bouton [Sélection]. e
= L'option <Manual> (Manuel) s’affiche & I'écran. o

FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de
présélection

Vous pouvez enregistrer jusqu’a 30 stations dans la mémoire de votre
lecteur MP3 et y accéder en appuyant simplement sur un chiffre.

Le lecteur MP3 peut soit choisir uniquement les stations souhaitées
(manuellement) ou rechercher et enregistrer automatiquement les
stations locales.

Manuel : sélectionnez uniquement les stations que vous souhaitez
enregistrer

1. Appuyez légérement sur le bouton [Gauche,
Droite] pour sélectionner une fréquence a
prérégler en mode manuel, puis sur [ @].

= Le menu <FM Radio> (Radio FM) s’affiche.

i 0427pM @

Manual

Go to Preset Mode

2. Appuyez légérement sur le bouton [Haut, Bas] ddto Preset
pour sélectionner <Add to Preset> (Ajouter aux Start Recording
présél.), puis sur le bouton [Sélection]. )

= La fréquence sélectionnée est ajoutée a la liste de
présélections.

3. Pour définir un numéro préréglé pour les autres fréquences,
suivez les étapes 1 a 2 ci-dessus.

’Q = Si la méme fréquence est déja définie, le réglage est désactivé.

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de
présélection (Suite)

Automatique : enregistrez automatiquement toutes les stations
captées par le lecteur

1. Appuyez légérement sur [ E] en mode Radio FM. &
= Le menu <FM Radio> (Radio FM) s’affiche.

Manual

2. Appuyez légerement sur le bouton [Haut, Bas] g
pour sélectionner <Auto Preset> (Présélection Go o Preset Mode
auto), puis sur le bouton [Sélection].

= Une fenétre de confirmation s’affiche.

Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

3. Appuyez légerement sur le bouton [Gauche,
Droite] pour sélectionner <Yes> (Oui), puis sur le
bouton [Sélection].

= Jusqu’a 30 fréquences radio sont réglées automatiquement.

Pour annuler la présélection automatique

Pour annuler la présélection automatique, appuyez légérement sur le
bouton [Sélection].

= La présélection automatique est annulée et seules les fréquences réglées
jusque-la sont enregistrées.

= Si vous vous rendez dans une autre région avec votre lecteur MP3,
remamque  VOUS souhaiterez peut-étre régler & nouveau les stations enregistrées.
Pour supprimer les stations préréglées et en enregistrer de nouvelles,
il suffit de répéter le processus.
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée

En mode Présélection, appuyez Iégérement sur le

bouton [Gauche, Droite] pour faire défiler les stations 8

présélectionnées. Preset

= Vous pouvez écouter la fréquence radio enregistrée. 91 gMH
. Z

News
Today Headline

Pour supprimer une présélection

Suivez les étapes suivantes pour supprimer les fréquences tout en
écoutant la radio FM.

1. En mode Présélection, appuyez légérement sur
le bouton [Gauche, Droite] pour rechercher une
fréquence présélectionnée a supprimer, puis sur [ @].
= Le menu <FM Radio> (Radio FM) s’affiche. ot o
Go to Manual Mode
2. Appuyez légérement sur le bouton [Haut, Bas] Delete from Preset

Auto Preset

pour sélectionner <Delete from Preset> (Suppr. Start Recording
sz . - . FM S itivity
du prérégl.), puis sur le bouton [Sélection]. FM Region

= La fréquence sélectionnée est supprimée.

3. Pour supprimer les autres fréquences présélectionnées, suivez les
étapes 1 a 2 ci-dessus.
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Enregistrer un programme FM

Vous pouvez a tout moment enregistrer un programme FM tout en écoutant la radio.
1. Appuyez légérement sur le bouton [Gauche, P
Droite] pour sélectionner une fréquence a

enregistrer en mode Radio FM, puis sur [ E]. Mangal
= Le menu <FM Radio> (Radio FM) s’affiche.

2. Appuygz Ié_gérement surle boutqn [Haut', Bas] o —
pour sélectionner <Start Recording> (Démarrer QUDIREEE]
I'enregistrement), puis sur le bouton [Sélection]. FM Sonsiivity_
= Le nom du fichier créé automatiquement s'affiche et FM Region

I'enregistrement démarre.
Pour arréter un enregistrement

1. Appuyez légérement sur le bouton [Sélection] £ i rocon See7PUES
pendant 'enregistrement. =2
= Un message apparait vous demandant si vous souhaitez
écouter le fichier que vous venez d’enregistrer.

2. Appuyez légérement sur le bouton [Gauche, 91.9whz
Droite] pour sélectionner <Yes> (Oui) ou <No>
. p . FM_080101_001.MP3
(Non) puis sur le bouton [Sélection].
= Sélectionner <Yes> (Oui) vous permet de lire le fichier que 00:00:01

vous venez d’enregistrer.
= Sélectionner <No> (Non) ne vous permet pas de lire le fichier enregistré.

= Le fichier est enregistré a 'emplacement suivant : <File Browser> (Dossier
rewamque  Navigateur) — <Recorded Files> (Fichiers Enregistrés)

= La durée maximale d’un fichier d’enregistrement radio FM est de 5 heures.

= Vous pouvez stocker jusqu’a 999 fichiers pour I'enregistrement radio FM.

= \ous pouvez effectuer jusqu’a 15 heures environ d’enregistrement (sur la base
de 128 Kbit/s, 1 Go).

= Le nom du fichier enregistré est spécifié automatiquement sous la forme : «
FM_AAMMJJ_XXX.MP3 ». « FM » signifie qu'il s’agit d’'un enregistrement de
la radio FM, « AAMMJJ » correspond a la date d’enregistrement et « XXX »
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour régler la Sensibilité FM

Pour recevoir plus ou moins de fréquences radio FM, paramétrez la

fonction FM Sensitivity (Sensibilité FM).

1. Appuyez légerement sur [ E] en mode Radio FM. & osz7ow am
= Le menu <FM Radio> (Radio FM) saffiche.

Manual

2. Appuyez légérement sur le bouton [Haut, Bas]
pour sélectionner <FM Sensitivity> (Sensibilité Goto Presat Mode
FM), puis sur le bouton [Sélection]. addio Preset

Auto Preset‘
= Le menu <FM Sensitivity> (Sensibilité FM) s’affiche. Start Recording

FM Sensitivity

P FM Region

3. Appuyez légerement sur le bouton [Haut, Bas]
pour sélectionner le niveau de recherche souhaité,

puis sur le bouton [Sélection].
= Choisissez entre <High> (Haut), <Middle> (Milieu) et <Low> (Bas).

= Le réglage <High> (Haut) vous permet de recevoir le plus grand nombre de
fréquences.

(#] = Pour quitter le menu, appuyez légérement sur [ B)].
REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Réglage de la région FM

Vous avez la possibilité de modifier le réglage FM en prévision d’'un
voyage a l'étranger.

1. Appuyez légérement sur [ @] en mode Radio FM.

=]
= Le menu <FM Radio> (Radio FM) s’affiche.
Manual
2. Appuyez légérement sur le bouton [Haut, Bas] :
pour sélectionner <FM Region> (Région Radio), Go to Presgt Mode
puis sur le bouton [Sélection]. g rreset
= Le menu <FM Region> (Région Radio) s’affiche. ?Eggﬂ“;ﬁ;“"‘;‘g
3. Appuyez légérement sur le bouton [Haut, Bas] ——

pour sélectionner la zone régionale de la radio FM,
puis sur le bouton [Sélection].

= Choisissez entre <Korea/US> (Corée/USA), <Japan> (Japon) ou <Other
Countries> (Autres pays).

= Les fréquences radio que vous avez enregistrées précédemment seront
remaraue  SUPpPrimées si vous modifiez le réglage <FM Region> (Région FM) de votre
lecteur.

= La région FM peut étre supprimée ou modifiée en fonction de la région cible
du lecteur.
= Bande de fréquences par région
- Korea/US (Corée/USA) : Recherchez des fréquences FM comprises entre
87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0
MHz et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries (Autres pays) : Recherchez des fréquences FM comprises
entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.
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AFFICHAGE DES DIFFUSIONS DE DONNEES

Vous pouvez afficher les éléments de chaine ajoutés a <Datacasts> (Dif. donn.).

= Avant de démarrer — Transfert de I'élément de chaine souhaité vers le lecteur avec
<EmoDio>.

= Qu’est-ce que la diffusion de données ?

remaraue  VOUS pouvez recevoir automatiquement les informations mises a jour sans avoir a vous
rendre sur les sites d’actualités, les blogs ou les UCC.
= Appuyez légérement sur [ © ] pour aller & I'écran précédent.

Appuyez longuement sur [ 5 ] pour accéder a I'écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder a I'écran du menu
principal. e
2. Appuyez légérement sur le bouton [Haut, Bas, Gauche, é éa S
Droite] pour sélectionner <Datacasts> (Dif. donn.), puis sur le *
bouton [Sélection]. TexTs FAADD. DaTACASTS
= La liste de diffusion s'affiche. ﬁ.‘ l('i $
3. Appuyez légérement sur le bouton [Haut, Bas] pour

sélectionner la liste de canaux souhaitée, puis sur le bouton
[Sélection].

MUSIC  VIDEOS  PICTURES

. - g Y

= La liste des fichiers s'affiche. W Datacasts
= Icone [ Texte principal de = |cdne :Fichier musical :

I'élément transféré I D

. L . P L L, M Datacast 3

= Icone :Fichier image = [cone & : Fichier vidéo M Datacast 4

4. Appuyez légérement sur le bouton [Haut, Bas] pour
sélectionner le fichier souhaité, puis sur le bouton [Sélection].
= La lecture du fichier sélectionné démarre.

rg = Reportez-vous a <Datacasts> (Dif. donn.) dans <EmoDi> (EmoDi) pour obtenir des
remarque  Instructions détaillées.
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Le pack plus vous permet d'utiliser différentes fonctions telles que les
jeux ou I'enregistrement vocal.

= Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.
ENREGISTREMENT VOCAL

Vous permet d’effectuer un enregistrement vocal.
Créer un enregistrement vocal

1. Appuyez longuement sur [ ©] pour accéder a I'écran
du menu principal. &K KB
2. Appuyez légérement sur le bouton [Haut, Bas, b e
Gauche, Droite] pour sélectionner <Prime Pack>
(Pack plus), puis sur le bouton [Sélection].
= La liste <Prime Pack> (Pack plus) s’affiche.

3. Appuyez légérement sur le bouton [Gauche, Droite]
pour sélectionner <Voice REC> (ENR vocal), puis
sur le bouton [Sélection].

4. Appuyez légerement sur le bouton [Sélection].
= Le lecteur démarre I'enregistrement.

rg = Le fichier est enregistré a 'emplacement suivant : <File Browser> (Dossier
remamaue  Navigateur) — <Recorded Files> (Fichiers Enregistrés).
= La durée maximale d’un fichier d’enregistrement vocal est de 5 heures.
= Vous pouvez stocker jusqu’a 999 fichiers pour I'enregistrement vocal.
= \Jous pouvez effectuer jusqu’a 15 heures environ d’enregistrement (sur la
base de 128 Kbit/s, 1 Go).
= Le nom du fichier enregistré est spécifié automatiquement sous la
forme « VCE_AAMMJJ_XXX.MP3 ». « VCE » signifie qu’il s’agit d’un
enregistrement vocal, « AAMMJJ » correspond a la date d’enregistrement
et « XXX » correspond au numéro du fichier enregistré.
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Enregistrement VOCAL (Suite)

Arréter I’enregistrement vocal

1. Appuyez légérement sur le bouton [Sélection]
pendant I'enregistrement.
= Un message apparait vous demandant si vous

souhaitez écouter le fichier que vous venez
d’enregistrer. L 2L I L

2. Appuyez légérement sur le bouton [Gauche,
Droite] pour sélectionner <Yes> (Oui) ou <No>
(Non) puis sur le bouton [Sélection]. 00:00:01

= Sélectionner <Yes> (Oui) vous permet de lire le fichier
que vous venez d’enregistrer.

= Sélectionner <No> (Non) ne vous permet pas de lire le fichier enregistré.

ae 0427pM @0
-, .
Voice Record

VCE_080101_001.MP3

= Ne tenez pas le microphone trop rapproché ou trop éloigné de votre
arrention  bouche car cela pourrait affecter la qualité de I'enregistrement.

= 'enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.
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LECTURE DE JEUX FLASH

Votre lecteur mp3 est livré avec des jeux passionnants qui sont préchargés sur I'appareil !

[Q = Appuyez légérement sur [ © | pour aller a I'écran précédent.
remaraue  Appuyez longuement sur [ ] pour accéder a I'écran du menu principal.

1.

2,

. Appuyez légerement sur le bouton [Gauche, Droite]

Appuyez longuement sur [ ] pour accéder a I'écran du P
menu principal. o KR A
Appuyez légérement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner <Prime Pack> (Pack plus), puis
sur le bouton [Sélection].

= La liste <Prime Pack> (Pack plus) s’affiche.

VOICEREC  GAMES|  SUBWAY.

pour sélectionner <Games> (Jeux), puis sur le bouton
[Sélection].
= La liste <Games> (Jeux) s’affiche.

. Appuyez légérement sur le bouton [Haut, Bas] pour sélectionner le jeu

souhaité, puis sur le bouton [Sélection].
BOMB BOMB

Ce jeu de réflexion consiste a déplacer trois blocs afin de faire

correspondre la couleur des blocs en forme de marteau avec celle des
blocs empilés, action qui permet de faire disparaitre les blocs. Enlevez
autant de blocs que possible.

Appuyez légérement sur le bouton [Gauche, Droite]
pour faire bouger les blocs vers la gauche ou la
droite.

Appuyez légérement sur le bouton [Haut] pour
déplacer les blocs sur le plan horizontal ou vertical.

Appuyez légérement sur le bouton [Bas] pour
déposer les blocs.
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LECTURE DE JEUX VIDEO (Suite)

7
M = Des jeux peuvent étre ajoutés ou modifiés sans avis préalable.

REMARQUE

Bubble Smile

Vous devez marquer le plus de points possibles en déplacgant trois
bulles afin de les aligner a I'horizontale ou en diagonale.

Appuyez légérement sur le bouton [Haut, Bas,
Gauche, Droite] pour déplacer la combinaison de
trois bulles.

Appuyez légérement sur [ E] pour modifier 'ordre
des bulles dans le sens des aiguilles d'une montre.

Appuyez legérement sur [ ] pour changer 'ordre
des bulles dans le sens contraire des aiguilles d’'une
montre.

Vous ne marquerez des points que si au moins trois
bulles sont alignées.

Chicken Runaway

Ce jeu consiste a déplacer une poule et des poulets de droite a gauche
et inversement, dans le but d’éviter les balles qui tombent du ciel afin
que la poule reste en sécurité le plus longtemps
possible.

Appuyez légérement sur le bouton [Gauche, Droite]
pour faire bouger la poule vers la gauche ou la droite.

Pour plus d'informations sur les régles du jeu, consultez la
section Aide.
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AFFICHAGE DE LA CARTE INTERNATIONALE DES METROS

Vous pouvez parcourir les plans des métros du monde entier en prenant notes
des différentes stations.

1. Appuyez longuement sur [*© ] pour accéder a I'écran du
menu principal. @ KR E
2. Appuyez légérement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner <Prime Pack> (Pack plus), puis
sur le bouton [Sélection].
= La liste <Prime Pack> (Pack plus) s’affiche.

3. Appuyez légérement sur le bouton [Gauche, Droite]
pour sélectionner <Subway> (Métro), puis sur le bouton
[Sélection].

= L’écran de sélection des pays du monde s’affiche.
4. Appuyez légérement sur le bouton [Haut, Bas, Gauche, Droite] pour
sélectionner la zone souhaitée, puis sur le bouton [Sélection].
= Sélectionnez un continent : <AMERICA> (AMERIQUE), <EUROPE> (EUROPE),
<ASIA/OCEANIA> (ASIE/ OCEANIE).
= Les villes de la région sélectionnée s’affichent.

5. Appuyez légérement sur le bouton [Gauche, Droite] pour sélectionner la
ville souhaitée, puis sur le bouton [Sélection].
= Le plan du métro de la ville sélectionnée s’affiche.

6. Appuyez légérement sur le bouton [Haut, Bas, Gauche, Droite] pour
sélectionner la zone a agrandir, puis sur le bouton [Sélection].
= Si la carte agrandie inclut des informations sur les attractions touristiques adjacentes

a la station de métro, appuyez légérement a nouveau sur le bouton [Sélection] pour
afficher la fleche rouge. Appuyez légerement sur le bouton [Haut, Bas, Gauche,
Droite] pour sélectionner I'icbne souhaitée, puis sur le bouton [Sélection]. Vous
pouvez repérer I'attraction touristique.

g = Appuyez légérement sur [ E] pour retourner sur I'écran de sélection des régions du

monde.
= |l se peut le plan différe du plan réel du métro.

VOICEREC  GAMES  SUBWAY

REMARQUE
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dégamag@—
Si vous rencontrez un probleme avec votre nouveau lecteur MP3, des

solutions vous sont proposées dans cette liste. Si le probleme persiste,
contactez le service clientéle Samsung le plus proche.

PROBLEME

SOLUTION

L’appareil ne s’allume
pas.

L’appareil ne s’allumera pas si la batterie est
entierement déchargée. Rechargez la batterie
et remettez I'appareil sous tension.

Appuyez sur le bouton de réinitialisation.

Les boutons ne
fonctionnent pas.

Vérifiez si l'interrupteur [0 (O] est
orienté vers le haut du lecteur.

Veérifiez que vous avez appuyé sur le bouton
adéquat, puis essayez a nouveau.

Appuyez sur le bouton de réinitialisation.

L’écran ne s’allume pas.

Il se peut que les données affichées a I'écran
ne soient pas visibles sous les rayons directs du
soleil.

Si <Display Off> (Affich. Désactivé) est
sélectionné dans <Settings> (Paramétres) —
<Display> (Afficher), I'écran s’éteint.

Appuyez sur un bouton et vérifiez si I'écran
s’allume.
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PROBLEME

SOLUTION

L’alimentation est
coupée.

L’alimentation se coupe automatiquement lorsque
la batterie est entiérement déchargée. Rechargez
la batterie.

Si <Auto Power Off> (Extinction auto) est
sélectionné dans <Settings> (Paramétres) —
<System> (Systéme), I'alimentation est coupée
lorsque le lecteur est en mode Pause. Allumez le
lecteur.

La durée de vie de

la batterie différe de
celle indiquée dans le
manuel.

L'autonomie de la batterie peut varier en fonction
du mode son utilisé et du réglage de I'affichage.
La durée de vie de la batterie peut étre réduite

si vous exposez le lecteur a des températures
basses ou élevées pendant des périodes
prolongées.

Dysfonctionnement du
programme EmoDio

Vérifiez que votre ordinateur dispose de la
configuration requise.

La connexion a
I'ordinateur est
interrompue.

Assurez-vous que le cable USB est branché
correctement et essayez a nouveau.

Exécutez la mise a jour de Windows sur votre
ordinateur. Sélectionnez les mises a jour
principales et 'ensemble des modifications
provisoires, puis mettez a jour tous les
composants. Redémarrez 'ordinateur et
rebranchez I'appareil.

Le taux de transfert du
fichier est trop lent.

Si plusieurs programmes sont ouverts sur votre
ordinateur (dont <EmoDio>), le taux de transfert
du fichier sera ralenti. Quittez les programmes
que vous n'utilisez pas et procédez a nouveau au
transfert.

dépannage _ 87



PROBLEME

SOLUTION

Le lecteur ne fonctionne
pas.

Vérifiez que le fichier disponible a bien été
enregistré dans la mémoire.

Assurez-vous que le fichier musical n’est pas
endommageé.

Vérifiez que la puissance de la batterie est
suffisante.

Les fichiers ne se
téléchargent pas.

Vérifiez que le cable USB est correctement
branché. Rebranchez-le au besoin.

Assurez-vous qu'’il reste de I'espace disponible
sur la mémoire.

Appuyez sur le bouton de réinitialisation.

Des fichiers ou des
données manquent.

Veérifiez que le cable USB n’a pas été débranché
durant le transfert du fichier ou des données.

Si tel est le cas, les fichiers/données

mais également I'appareil risquent d’étre
endommagés.

Vous devez faire preuve d’'une extréme
prudence a cet égard car Samsung ne saurait
en aucun cas étre tenu responsable de la perte
des données.

Affichage anormal de la
durée de lecture.

Vérifiez que le fichier est au format VBR (débit
binaire variable).

L’appareil est chaud.

Les phases de chargement peuvent générer
de la chaleur. Cela n’a aucune incidence

sur la durée de vie de I'appareil ou sur son
fonctionnement.

Un message s’affiche
pendant le visionnage
d’une vidéo

Essayez a nouveau de télécharger le clip vidéo
en passant par le logiciel EmoDio.
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dNnexe

ARBORESCENCE DES MENUS

Voici une rapide présentation de la fagon dont les menus et les fonctions sont
organisés dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Aller au mode

Effets Ajouter Musique  Musique pré-progr / ENR vocal Style du
Sonores signet activée activée  Aller au mode menu
manuel
i A : : Ajouter aux
Accéd.a  RadioFM  Radio FM 3 Jeux Son
DNSe ; Ao = présél. / Suppr.
Signet activée activée du prérégl.
Mode Supprimer Start Allerala  Présélection Métro Afficher
lecture signet Slideshow  1ére page auto
Ecran Lect oyl Ajouter Démarrer
mus. Lot Zoon signet I'enregistrement Sagdiads
Vitesse de  pnge Pivoter  A%%€d- 3 sensiilite FM Date et
lecture Signet heure
Saut Pivot Supprimer o s
Intervalle automatique signet Reftom (Rerile Systéme
Mode Effet de Coul. v
Répéter A- o visionn.
B activé text
Sél.
comme Taille police
habillage
Type
d’affichage
Langue
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CARACTERISTIQUES DU PRODUIT

Nom du modéle YP-Q1
Puissance nominale 5,0 V.CC /500 mA
Alimentation de la batterie 620 MAR/3,7 V CC

intégrée

Compatibilité

AUDIO : MPEG1/2/2.5 Couche 3 (8 kbps a 320 kbps,
22 kHz a 48 kHz), WMA (8 kbps a 320 kbps,
8 kHz a 48 kHz)

VIDEO : SVI (Vidéo : MPEG4, Audio : MP3 (44,1 kHz,
128 Kbps),
WMV (Vidéo : WMV9 Profil simple, Audio :
WMA Spec (Max 860 kbps), Résolution : 480
x 272, Vitesse d’enregistrement : 30 fps)

IMAGE : JPEG (ISO/IEC 10918-1/Annexe F — Mode
de fonctionnement séquentiel DCT)

Nombre de dossiers/
fichiers pris en charge

Dossiers : 1 000 maxi ; Fichiers : 6 000 maxi.
(dossier compris)

Sortie des écouteurs

20 mW/Ch. (France 5 mW/Ch.) (basé sur 16 Q)

Bande de fréquences de la
sortie

40Hz~20kHz

Rapport signal-bruit

90 dB

Durée de lecture

Musique : 30 heures maxi. (MP3 128 kbps,
Volume : 15, Mode Normal, LCD Off)
Vidéo : 4 heures maxi. (Luminosité 5, Volume : 15,
Mode Normal)

Plage de températures de
fonctionnement

-5~ 35°C (23~95°F)

Etui

Plastique

Poids

659

Dimensions (L x H x P)

51X 98 X 10,9 mm
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Radio Fréquence FM

87,5~108,0 MHz

T.H.D. FM

1%

FM Rapport signal FM

55dB

Sensibilité FM utile

38 dBy

Le contenu de ce manuel est susceptible d’étre modifié en vue d’étre amélioré

sans notification préalable.

annexe _ 91



LICENCE

L’appareil qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée
a une utilisation privée non commerciale par I'utilisateur final pour les contenus sous
licence.

Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniquement I'utilisation de ce produit pour encoder et/ou décoder
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit
n'est cédé sous cette licence pour des caractéristiques ou des fonctions du produit
qui ne sont pas conformes a la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

COMMENT ELIMINER CE PRODUIT (DECHETS
D’EQUIPEMENTS ELECTRIQUES ET ELECTRONIQUES)

(Applicable dans les pays de I'Union Européen et aux autres pays européens
disposant de systémes de collecte sélective)

Ce symbole sur le produit ou sa documentation indique qu'il

ne doit pas étre éliminé en fin de vie avec les autres déchets

ménagers. L’élimination incontr6lée des déchets pouvant

porter préjudice a I'environnement ou a la santé humaine,

veuillez le séparer des autres types de déchets et le recycler

de fagon responsable. Vous favoriserez ainsi la réutilisation

durable des ressources matérielles.

Les particuliers sont invités a contacter le distributeur

leur ayant vendu le produit ou a se renseigner aupres

de leur mairie pour savoir ou et comment ils peuvent se

débarrasser de ce produit afin qu'il soit recyclé en respectant _
I'environnement.

Les entreprises sont invitées a contacter leurs fournisseurs et

a consulter les conditions de leur contrat de vente.

Ce produit ne doit pas étre éliminé avec les autres déchets commerciaux.
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ELIMINATION DES BATTERIES DE CE PRODUIT

(Applicable aux pays de I'Union européenne et aux autres pays européens
dans lesquels des systemes de collecte sélective sont mis en place.)

Le symbole sur la batterie, le manuel ou 'emballage
indique que les batteries de ce produit ne doivent pas étre
éliminées en fin de vie avec les autres déchets ménagers.
L'indication éventuelle des symboles chimiques Hg, Cd

ou Pb signifie que la batterie contient des quantités de
mercure, de cadmium ou de plomb supérieures aux
niveaux de référence stipulés dans la directive CE 2006/66.
Si les batteries ne sont pas correctement éliminées, ces
substances peuvent porter préjudice a la santé humaine ou
a I'environnement.

Afin de protéger les ressources naturelles et d’encourager la réutilisation du
matériel, veillez a séparer les batteries des autres types de déchets et a les
recycler via votre systéme local de collecte gratuite des batteries.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.
Samsung Service Consommateurs
3260 SAMSUNG (€ 0,15/Min) ou 08 25 08 65 65 (€ 0,15/Min)
www.samsung.com/fr
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